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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
http://www.okiprintingsolutions.com

Copyright © 2009  All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.

As an Energy Star Program Participant, the manufacturer has determined that 
this product meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/
108/EC (EMC), 2006/95/EC (LVD) and 1999/5/EC (R&TTE), as amended 
where applicable, on the approximation of the laws of the member states 
relating to electromagnetic compatibility, low voltage and radio & 
telecommunications terminal equipment.

The following cables were used to evaluate this product to achieve EMC directive 
2004/108/EC compliance and configurations other than this may affect that compliance.

CABLE TYPE LENGTH 
(METRE)

CORE SHIELD

Power 1.8 ✘ ✘

USB 3.0 ✘ ✔

Parallel 2.0 ✘ ✔

LAN 2.0 ✘ ✘

Tel 3.0 ✔ ✘

Modular 5.0 ✔ ✘
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EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical 
attention. DO NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical 
attention.

If it gets into the eyes, flush with large amounts of water for at least 
15 minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce 
risk of staining skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

ENVIRONMENTAL INFORMATION
Emergency first aid > 3
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NOTES, CAUTIONS AND WARNINGS

For the protection of your product, and in order to ensure that you benefit from its full 
functionality, this model has been designed to operate only with genuine original toner 
cartridges. Any other toner cartridge may not operate at all, even if it is described as 
“compatible”, and if it does work, your product's performance and print quality may be 
degraded.

Use of non-genuine products may invalidate your warranty.

Specifications subject to change without notice. All trademarks acknowledged.

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
Notes, cautions and warnings > 7



ABOUT THIS GUIDE

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you 
become familiar with your product and to make the best use of its many powerful features. 
The documentation is summarised below for reference and is found on the manuals CD 
unless indicated otherwise:

> Installation Safety booklet: provides information for safe use of your product.

This is a paper document that is packaged with the product and should be read before 
setting up your machine.

> Set-up guide: describes how to unpack, connect and turn on your product.

This is a paper document that is packaged with the product.

> User’s Guide: helps you become familiar with your product and make the best use 
of its many features. Also included are guidelines for troubleshooting and 
maintenance to ensure that it performs at its best. Additionally, information is 
provided for adding optional accessories as your printing needs evolve.

> Network Guide: helps you become familiar with the functionality of the built in 
network interface card.

> Installation Guides: accompany consumable items and optional accessories to 
describe how to install them.

These are paper documents that are packaged with the consumables and optional 
accessories.

> On-line Help: on-line information accessible from the printer driver and utility 
software.

NOTE
Images used in this manual may include optional features that your product 
does not have installed.
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ON-LINE USAGE

This guide is intended to be read on screen using an Adobe Reader. Use the navigation and 
viewing tools provided in Adobe Reader.

There are many cross-references within this book, each highlighted as blue text. When you 
click on a cross-reference the display will instantly jump to the part of the manual 
containing the referenced material. 

By using the  button in Adobe Reader, you can navigate directly back to where you were 
before.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of 
interest to jump to the required topic. (If the bookmarks are not available, use the 
“Contents” on page 4.)

> In the list of bookmarks, click on Index to jump to the Index. (If the bookmarks are 
not available, use the “Contents” on page 4.) Find the term of interest in the 
alphabetically arranged index and click on the associated page number to jump to 
the page containing the term.

PRINTING PAGES

The whole manual, individual pages, or sections may be printed. The procedure is:

1. From the toolbar, select File > Print (or press the Ctrl + P keys).

2. Choose which pages you wish to print:

(a) All pages, (1), for the entire manual.

(b) Current page, (2), for the page at which you are looking.

(c) Pages from and to, (3), for the range of pages you specify by entering their 
page numbers.

(d) Click OK.

1 
2 
3 
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INTRODUCTION
Congratulations on choosing this Multi Function Product (MFP). It is designed with 
advanced features, to give you clear and crisp black and white pages at high speed on a 
range of office print media.

With this MFP, you can instantly scan paper-based documents and deliver the electronic 
image to various destinations including e-mail addresses, printers, ftp servers, fascimile 
machines or someone else's computer on the network. 

Your MFP includes these features:

> Digital copying - An intutive control panel, makes digital copying fast and easy.

> Up to 21 copies per minute (A4 SEF) and 22 copies per minute (Letter) in black and 
white for fast and efficient copying.

> Up to 600 x 600dpi (dots per inch) copy resolution.

> Actkey utility (Windows only) - enables the MFP to receive one key touch commands 
from a locally connected computer (“pull scan”).

> Scan to E-mail - Connected to an Ethernet network and a SMTP server, this MFP 
allows you to transmit document(s) over the internet via e-mail. With a touch of the 
e-mail button and the selection of your recipients' e-mail addresses, the 
document(s) is/are first scanned and converted into an image file, and then 
transmitted to remote recipients within minutes.

> Scan to Network PC - Allows you to send scanned documents (PDF, TIFF and JPEG 
file formats) to a server or a personal computer's file folder over an intranet with FTP 
(File Transfer Protocol), CIFS (Common Internet File System) protocol. The scan to 
filing feature removes the need for the mail server to handle large attachments.

> Network/PC Printing - When connected to a Network, the MFP is able to perform 
network or PC printing.

> Multiple Pages Sending - With the Auto Document Feeder (ADF), the MFP allows a 
stack of up to 50 page document(s) to be continuously scanned.

> Faxing (MB470/MB480) - An intuitive control panel, makes direct faxing fast and 
easy.

> Advanced fax transmission and reception, including delayed transmissions, sending 
to multiple locations.

> Address Book/Profiles Managing - This provides a convenient way to manage all the 
e-mail addresses and profiles (filing destinations). 

> The MFP’s setup tool utility allows you to create up to 100 e-mail addresses and 
several filing destinations to manage your document.

> 600 x 2400dpi (dots per inch) for MB460 and 1200 x 1200dpi for MB470/MB480 
print resolution for high quality image production showing the finest detail.

> Automatic two-sided (duplex) printing for economical use of paper and compact 
printing of larger documents.

> High speed USB 2.0 interface.

> Emulation: standard PCL6, PCL5e and PostScript 3 for MB470/MB480.

> Paper handling: 250 sheets (80g/m2) for MB460/MB470 and 530 sheets (80g/m2) 
for MB480.

> Template Manager utility for Windows enables the design and print of business 
cards, banners, labels with ease.

> “Ask Oki” (Windows only) – a user-friendly function that gives a direct link from your 
printer driver screen (but not always illustrated in this guide) to a dedicated web site 
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specific to the exact model you are using. This is where you’ll find all the advice, 
assistance and support you could need to help you get the best possible results from 
your printer.

The following optional features are available:

> Additional memory, to allow printing of more complex pages.

> One additional paper tray for loading a further 530 sheets.
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MFP OVERVIEW

FRONT VIEW

REF. DESCRIPTION

1. Output stacker, face down

Standard printed copy delivery point. Holds up to 150 sheets at 80g/m2.

2. Top cover release button 

Press to open.

3. Multi purpose tray release handles

Pull to open.

4. Multi purpose tray 

Used for feeding heavier paper stocks, envelopes and other special media. 

MB460: Manual feeding of single sheets.

MB470/MB480: Holds up to 50 sheets of 80g/m2 paper. Also has an extendable paper support.

5. Paper tray

Standard blank paper tray.

MB460/MB470: Holds up to 250 sheets of 80g/m2 paper.

MB480: Holds up to 530 sheets of 80g/m2.

6. Paper level lever 

To visually indicate the paper level in the tray.

7. ON/OFF power switch

Refer to “Switching off” on page 17 for details.

8. Scanner Bed

9. ADF unit

10. ADF paper tray

Holds up to 50 sheets of A4 size paper at 80g/m2.

11. Document cover

1

2

3

4

5

6
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10

7
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REAR VIEW

12. Control panel 

With LCD and operator buttons. 

One touch key (shown) is only for MB470/MB480. Refer to “Control panel” on page 14.

REF. DESCRIPTION

13. Access panel

Allows access to install optional memory.

14. Duplex unit

Provides automatic two-sided printing.

15. Rear output cover (closed) (face up stacker)

This is mainly used for heavy print media. When used in conjunction with the multi purpose 
feed tray, the paper path through the MFP is essentially straight. This avoids bending the paper 
around curves in the paper path.

16. AC power socket

17. Parallel connector

18. USB connector 

19. Test switch

20. Network connection

21. Line connection (MB470/MB480)

Socket for connecting the machine to the telephone line.

Tel connection (MB470/MB480)

Socket for connecting a telephone handset (if required).

REF. DESCRIPTION

13
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21
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CONTROL PANEL

REF. DESCRIPTION

1. Key Pad

Used to enter numbers, upper-case/lower-case letters and symbols in the Entry Line. Refer to 
“Character switching” on page 15 for further details.

2. Left Key

When in Switching mode: Returns the display to the Function Selection screen or Scan Sub Function 
Selection screen from the Stand-by screen.

When Setting up: Increments the value of the tree structure.

3. Down Key

When setting up or in switching mode: Moves the cursor down.

4. Right Key

When in Switching mode: 
> Used to confirm the Mode selected.
> Used to start Push scan (if push scan is selected, the executing Push Scan screen is displayed.)

When Setting up: 
> Decrements the value of the tree structure.

5. Up Key

When setting up or in Switching mode: Moves the cursor up.

6. Enter Key

When in Switching mode:
> Used to confirm the Mode selected.
> Used to start Push Scan (If Push scan is selected, the Executing Push scan screen is displayed.)

When Setting up:
> Decrements the value of the tree structure.
> Increments the value of the tree structure as the set value is confirmed.

When entering Pin ID:

Used to confirm the PIN ID entered.

Recovery from Error/Warning states.

7. One Touch Key (MB470/MB480): Used to dial numbers from #00 to #09 that are registered as 
fax numbers.
The shift key switches between a group of numbers from #00 to #04 and a group of numbers #05 to 
#09. 

1065 9

874321
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CHARACTER SWITCHING

Numbers, upper and lower case letters and symbols can be entered using the keypad. Press 
the key multiple times to switch between characters.

The example below is based on English being the display language:

8. Start Button:
> Executes the function selected.
> Executes Copy.
> Executes Scan to E-mail/Memory/Network PC.
> Executes Fax Send (MB470/MB480).
> Executes Fax Manual Receive (MB470/MB480).

Recovery from Error/Warning states.

9. Stop Button:
> Stops the function being executed.
> Stops Copy.
> Stops Scan to E-mail/Memory/Network PC.
> Stops Fax Send (MB470/MB480).
> Cancels a Print job.

10. Liquid Crystal Display (LCD): 128 x 64 dots.

NOTE
When pressing multiple times, you must re-press the key within 2 seconds of 
the previous press.

KEY AVAILABLE CHARACTERS

1 1 -> 1

2 a -> b -> c -> A -> B -> C -> 2

3 d -> e -> f -> D -> E -> F -> 3

4 g -> h -> i -> G -> H -> I -> 4

5 j -> k -> l -> J -> K -> L -> 5

6 m -> n -> o -> M -> N -> O -> 6

7 p -> q -> r -> s -> P -> Q -> R -> S -> 7

REF. DESCRIPTION

1065 9
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CHANGING THE DISPLAY LANGUAGE

The default language used by your MFP for display messages and for report printing is 
English1. If required, this can be changed using the Panel Language Setup utility. 

8 t -> u -> v -> T -> U -> V -> 8

9 w -> x -> y -> z -> W -> X -> Y -> Z -> 9

0 SP (space) -> 0 -> SP (Space)

* @ -> * -> a

# . -> _ -> - -> P -> SP (space) -> + -> ! -> “ -> $ -> % -> & -> ‘ -> ( 
-> ) -> , -> / -> : -> ; -> < -> = -> > -> ? ->  [ -> £ -> ] -> ^ -> #

German Danish

French Dutch

Italian Portuguese

Spanish Polish

Swedish Czech

Hungarian Turkish

Norwegian Russian

Greek Finnish

Brazilian Portuguese

NOTE
1. The above list is not exhaustive or conclusive.

2. See the information enclosed with the product (the Panel Language Setup 
Utility) on the procedure for changing the language.

1. To ensure your product contains the latest firmware updates, it is recommended that you download 
the language files from this utility during setup.

KEY AVAILABLE CHARACTERS
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GETTING STARTED

RELEASING THE SCANNER LOCK

1. Open the document cover.

2. Move scan lock lever to the UNLOCKED position.

POWER SAVING MODE

If you do not use the MFP for a while, the machine will enter the power saving mode to 
control the power consumption of the device. 

SWITCHING OFF

1. Press the down arrow button on the control panel to highlight Menu, press Enter to 
select.

2. Press the down arrow button on the Control panel to highlight System Shutdown, 
press Enter to select.

3. Press Enter to execute.

4. At the prompt, turn the power switch OFF.

CAUTION!

Make sure the scanner is in the UNLOCKED position before 
operating.

CAUTION!

Do not turn off the power switch suddenly as this may damage your 
MFP. 
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INSTALLING DRIVERS AND UTILITIES

Your machine is supplied with the following drivers:

> TWAIN driver (only use when connecting to the MFP via USB) (Windows only)

> Printer driver: PCL5e, PCL 6, PostScript3 (MB470/MB480)

> Fax driver (MB470/MB480) (Windows only)

The installation instructions below refer to USB connection. For network connection details 
refer to the Network Guide.

If you are running windows Server 2003 or Server 2008, you may need to follow these 
steps to ensure WIA service starts when using the TWAIN driver and Actkey Utility.

1. Click Start > Administrative Tools > Services.

2. Double-click Services.

3. Double-click Windows Image Acquisition (WIA).

4. From the Startup type menu, select Automatic.

5. Under Service status, click Start.

6. Click OK.

WINDOWS - TWAIN AND PRINTER DRIVERS

The TWAIN driver is used for “Pull Scanning”, i.e. initiating a scan from your computer via 
software. Compare this to “Push Scanning” where you start the scan by pressing a button 
on the MFP's front panel. The TWAIN driver only works via USB connections. This means 
it's not possible to control the scanner over the network from your computer.

There are two different ways of installing the TWAIN and printer drivers:

1. Plugging the printer in first and performing a “Plug and play” type of installation. In 
this case you must install the TWAIN driver first.

2. Not plugging the printer in yet, but running the Oki driver installer program from the 
CD-ROM. This installs the TWAIN (scanner driver) and printer drivers. Once the 
printer is switched on and plugged in, Windows completes the installation 
automatically.

NOTE
You must be logged on as an administrator or a member of the Administrators 
group in order to complete this procedure. If your computer is connected to a 
network, network policy settings may also prevent you from completing this 
procedure.

NOTE
> The Oki driver installer program is the recommended installation method.

> “Plug and play” installation only applies when connecting to your machine 
via USB.
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Plug and play installation

The MFP is a “dual device” - Windows sees it as a scanner and a printer. This means when 
the MFP is plugged into a PC using a USB cable, you'll be prompted to install two different 
drivers; the TWAIN (scanner) driver first and then the printer driver.

1. Attach the printer to a USB port of your computer. 

2. Switch on the Printer.

3. Insert the Drivers & Utilities CD.

If the CD runs automatically, cancel the dialogue.

The ‘New Hardware Found' dialogue will display.

If you do not see the ‘New Hardware Found' dialogue, please check that power and 
USB cables are connected properly, and the printer is switched on. 

4. Install TWAIN driver first 

b

c

a

d
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5. Next install the Printer driver 

MAC OS X- PRINTER DRIVER

The information in this section is based on Mac OS X Leopard (10.5). Other versions may 
appear slightly different, but the principles are same.

1. Insert the CD-ROM and run the Oki driver installer program.

2. Follow the on-screen instructions to install the printer driver.

3. Attach the printer to a USB port of your computer.

4. Switch on the printer.

5. Choose Apple Menu > System Preferences > Print & Fax.

6. If the printer is already in the list of printers, click “-” to remove it.

7. Click “+” to add a new printer.

8. Click More Printers.

9. Choose OKI USB from the pop-up menu.

NOTE
This is necessary as Leopard may not be using the correct Oki printer driver 
files.

d

b

c

a

MB4
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10. Select your printer model and click Add.

11. The printer is added to the list of printers.

12. Restart your computer.

FAX DRIVER - WINDOWS ONLY

The fax driver allows you to send faxes directly from your computer without printing the 
document first. With the fax driver you are sending the fax data from your computer to the 
MFP, and then the MFP automatically sends the document.

Windows XP has built-in fax support - you can use your computers modem to send faxes 
directly from your computer.

Installing the fax driver

This is installed as part of the Oki driver installer wizard.

MFP SETUP TOOL - WINDOWS ONLY

Installation of the MFP setup utility is optional and can be found on the CD under the 
Utilities folder.

The MFP setup tool can discover the MB460/MB470/MB480 devices over USB or network 
connections. To discover, select File > Printer Discovery.

The MFP setup tool allows you to configure your MFP. Refer to “Pre-configuration 
information” on page 32 for detailed instructions.

NOTE
Please refer to the readme file on the CD for details on installing the 
appropriate Macintosh driver.

MB470/MB480: You can choose PCL or PS driver on the Macintosh Operating 
System.
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ACTKEY UTILITY - WINDOWS ONLY  

The Actkey utility enables the MFP to receive one key touch commands from a locally 
connected computer.

Installation of the Actkey utility is optional and can be found on the Driver/Utilities CD 
under the Utilities folder.

Information on using the Actkey utility can be found in “Scan to PC” on page 65.

Setting up the Actkey utility

1. Install the Actkey utility from the CD:

Set-up will place an “Actkey” icon on your desktop.

2. Double-click this icon to open the Actkey console.

3. Select Options > Button Settings. The following screen displays.

4. Select the function you want to set in section (1).

5. Set the parameters for this function in section (2).

6. When you have completed settings, press OK (3).

The Utility will return to the Actkey console.

NOTE
The Actkey utility only works via USB connections.

You must have the TWAIN driver installed.

3

2

1
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7. To use Actkey in Local PC mode (i.e. push scanning), it must be set as the program 
to handle scanner events:

(a) Select Start > Control Panel.

(b) Double-click Scanners and Cameras.

(c) Right-click the MFP icon and click Properties.

(d) Select the Events tab.

(e) Choose an event from the Select an event drop-down menu.

(f) In the Actions field, click Start this program and choose ActKey from the 
drop-down menu.

(g) Click Apply.

(h) Repeat steps e to g for each event, e.g. Scan to Application, E-mail, Folder and 
PC-Fax.

(i) Click OK to confirm.

NOTE
The following example uses Windows XP. The steps may vary if you are using 
any other operating system, but the principle is the same.
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PAPER RECOMMENDATIONS

Your MFP will handle a variety of print media, including a range of paper weights and sizes, 
transparencies and envelopes. This section provides general advice on choice of media, and 
explains how to use each type.

The best performance will be obtained when using standard 60 - 120g/m2 paper designed 
for use in copiers and laser printers. 

Use of heavily embossed or very rough textured paper is not recommended.

Pre-printed stationery can be used, but the ink must not offset when exposed to the high 
fuser temperatures used in the printing process.

CASSETTE TRAYS 

The Cassette Tray can handle paper weights of 60g/m2 to 120g/m2. The Cassette Tray is 
ideal for printing A4 documents for more than 1 page in length. 

If you have identical paper stock loaded in another tray (the optional 2nd or the multi 
purpose tray) you can have the MFP switch to another tray when the current tray runs out 
of paper. When printing from Windows applications, this function is enabled in the driver 
settings. When printing from other systems, this function is enabled in the Printer menu.

MULTI PURPOSE TRAY

The multi purpose tray can handle the same media sizes as the cassette trays but in 
weights from 60g/m2 up to 163g/m2. For very heavy paper stock, use the face up (rear 
cover) paper stacker. This ensures that the paper path through the MFP is almost straight.

SIZE DIMENSIONS WEIGHT (G/M2)

A5 148 x 210mm

Light                 60 - 63 g/m2

Medium Light     64 - 74 g/m2

Medium             75 - 89 g/m2

Medium Heavy    90 - 104 g/m2

Heavy                105 - 120 g/m2

B5 182 x 257mm

Executive 184.2 x 266.7mm

A4 210 x 297mm

Letter 216 x 279mm

Legal 13 216 x 330mm

Legal 13.5 216 x 343mm

Legal 14 216 x 356mm

Statement 139.7 x 215.9mm

NOTE
The optional second tray can also handle the above paper sizes except for 
Statement.
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Use the multi purpose tray for printing on envelopes and transparencies. Up to 50 sheets 
of transparencies or 10 envelopes can be loaded at one time, subject to a maximum 
stacking depth of 10mm for MB470 and MB480 and one sheet at a time for MB460. 

Envelopes

Transparencies

Recommended type is CG3300 by 3M (A4 or Letter size).

SIZE DIMENSIONS WEIGHT

A6 105 x 148mm

Light                 60 - 63 g/m2

Medium Light     64 - 74 g/m2

Medium             75 - 89 g/m2

Medium Heavy    90 - 104 g/m2

Heavy                105 - 120 g/m2

   

A5 148 x 210mm

A4 210 x 297mm

B5 182 x 257mm

Letter 215.9 x 279.4mm

Executive 184.2 x 266.7mm

Legal 13 216 x 330mm

Legal 13.5 216 x 343mm

Legal 14 216 x 356mm

Statement 139.7 x 215.9mm

Com-9 Envelope 98.4 x 225.4mm

Com-10 Envelope 104.7 x 241.3mm

Monarch Envelope 98.4 x 190.5mm

DL Envelope 109.9 x 219.9mm

C5 Envelope 162 x 229mm

C6 114 x 162mm

Custom: Width

Length

86 ~ 216 mm

140 ~ 355.6 mm 

NOTE
Label mode must be selected in the printer driver, if you want to print on 
heavy media which exceeds 120 g/m2.

CAUTION!

Envelopes should be free from twist, curl or other deformations. 
They should also be of the rectangular flap type, with glue that 
remains intact when subjected to hot roll pressure fusing used in 
this type of printer. Window envelopes are not suitable.

CAUTION!

Do not use transparencies designed for use in colour laser printers 
and photocopiers. 
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Labels

FACE DOWN STACKER

The face down stacker on the top of the MFP can hold up to 150 sheets of 64g/m2 standard 
paper and can handle paper stocks up to 120g/m2. Pages printed in reading order (page 1 
first) will be sorted in reading order (last page on top, facing down).

FACE UP STACKER

For the face up stacker, cover at the rear of the MFP should be opened when required for 
use. In this condition paper will exit via this path, regardless of driver settings.

Always use this stacker and the multi purpose feeder for heavy paper stocks.

DUPLEX UNIT

The duplex unit provides automatic two-sided printing on the same range of paper sizes as 
tray 2 (i.e. all cassette sizes except A6), using paper stocks from 75-105g/m2.

CAUTION!

Labels should cover entire carrier sheet. The carrier sheet or 
adhesive must not be exposed to any part of the printer.
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LOADING PAPER

CASSETTE TRAYS

1. Remove the paper tray from the MFP.

2. Fan the paper to be loaded at the edges (1) and in the middle (2) to ensure that all 
sheets are properly separated, then tap the edges of the stack on a flat surface to 
make it flush again (3).

3. Load paper short edge feed (SEF) (1) (for letter headed paper load face down with 
top edge towards the front of the paper tray) up to mark (a). The paper level 
indicator (2) provides a visual indication of how much paper is left in the tray.   

1
2

3

1

2

1

a
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4. Adjust the rear stopper (3) and paper guides (4) to the size of paper being used.
For loading A4 or Legal size paper, push the lever in the arrow direction (b) and 
extend the paper tray using the rear paper stopper.

5. If required, set the correct media type in the Printer menu. “Tray1 Config” on 
page 47.

To prevent paper jams:

> Do not leave space between the paper and the guides and rear stopper.

> Do not overfill the paper tray. Capacity depends on the type of paper stock.

> Do not load damaged paper.

> Do not load paper of different sizes or types at the same time.

> Close the paper tray gently.

> Do not pull the paper tray out during printing (except as described below for the 
2nd tray).

NOTE
> If you have two trays (optional second tray fitted) and you are printing 

from the 1st (upper) tray, you can pull out the 2nd (lower) tray during 
printing to reload it. However, if printing from the 2nd tray, do not pull out 
the 1st tray. This will cause a paper jam. 

> For face down printing, make sure the face up (rear cover) stacker is 
closed (the paper exits from the top of the MFP). Stacking capacity is 
approximately 150 sheets, depending on paper weight.

> For face up printing, make sure the face up (rear cover) stacker is open 
Always use the face up (rear cover) stacker for heavy paper (card stock, 
etc.).

CAUTION!

Do not open or close the rear paper exit while printing as it may 
result in a paper jam.

3

4

b

Getting started > 28



6. Replace the tray in the MFP.
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MULTI PURPOSE TRAY

1. Open the multi purpose tray (1).

For MB470/MB480: Fold out the paper support (a).

2. Press gently down on the paper platform (2) to ensure it is latched down.

3. Adjust the paper guides (3) to the size of paper being used.

For MB460: Load single sheet at a time in to the Multi purpose tray.

For MB470/MB480: Do not exceed the paper capacity of about 50 sheets or
10 envelopes. Maximum stacking depth is 10mm. Press the tray latch button (4) 
inwards to release the paper platform, so that the paper is lifted and gripped in place.

> For single-sided printing on headed paper load the paper into the multi purpose 
tray with pre-printed side up and top edge into the MFP.

1
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> For two-sided (duplex) printing on headed paper load the paper with pre-printed 
side down and the top edge away from the MFP.

> Envelopes should be loaded face up with top edge to the left and short edge into 
the MFP. Do not select duplex printing on envelopes.

> Load transparencies face up and top edge into the MFP.

4. Set the correct paper size for the multi purpose tray in the Printer menu.

For MB460: see “Manual Feeder Config (MB460)” on page 47.
For MB470/MB480: see “MP Tray Config (MB470/MB480)” on page 47.
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CONFIGURING YOUR MACHINE...

MINIMUM CONFIGURATION REQUIREMENTS

To make the best of this MFP, the following configuration is required:

To send faxes (MB470/MB480):

A PSTN telephone line connection.

To send e-mails:

> TCP/IP network.

> A SMTP and an optional POP3 server.

> Default “From” Address (this MFP’s Address).

To file document(s) via intranet

> FTP or CIFS Protocol environment.

> Windows 2000, Windows XP, Windows Vista, Mac OS X or FTP server.

PRE-CONFIGURATION INFORMATION

GENERAL

Ensure that you have the relevant permission/PIN numbers before commencing.

The factory set default passwords/PIN are:

Administrator aaaaaa

PIN 000000

Network (webpage) aaaaaa

FAX SET UP (MB470/MB480)

Your MFP has to be set up properly to allow faxing from the machine. The following 
parameters must be set before using the fax function:

> Date and time

> Country code

> Local phone number

> Sender ID

See “Initial set up” on page 50 for details.

NOTE
The administrator password and PIN should be changed and maintained by the 
system administrator.

NOTE
If you ran the Oki driver installer program from the CD-ROM you may have 
already set the time zone, date and time (Windows only) via the Panel 
Language Setup utility.
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NETWORK SET UP

The MFP must also be set up properly on your network to perform scan to e-mail and other 
functions. In order for other network devices to find the MFP on the network, the following 
network parameters have to be set.

1. IP Address Set:

2. IP Address:.    .    .

3. Subnet Mask:.    .    .

4. Gateway Address:.    .    .

5. DNS Server:.    .    .

6. SMTP Server:.    .    .

7. SMTP Port:25

8. POP3 Server:.    .    .

9. POP3 Port:110 

Explanation:

1. IP Address Set:

Choose Auto to obtain IP/subnet/gateway addresses automatically from DHCP server. 
After changing setting from Manual to Auto, the MFP will automatically reboot the 
network card.

2. IP Address:

The Internet Protocol (IP) address assigned to your machine by your network 
administrator.

3. Subnet Mask:

The net mask address assigned by your network administrator.

4. Gateway Address:

The gateway IP address assigned by your network administrator.

5. SMTP Server:

The IP address of your SMTP Mail Server assigned by your network administrator.

6. SMTP Port:

The port number of your SMTP Mail Server.

7. DNS Server:

The IP address of DNS Server assigned by your network administrator.

8. POP3 Server:

The IP address of your POP3 server. 

9. POP3 Port:

The port number of your POP3 Server.

Enter the DNS name, or IP and port number of your POP3 server if your mail server 
requires POP3 authentication, before sending e-mails from the machine.

NOTE
You must also set up the “From” details to allow e-mail sending.
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INTERNET COMMUNICATION FEATURES

Scan to e-mail 

The MFP allows you to deliver your scanned document to e-mail addresses on the network. 
The document is first scanned and converted to a standard PDF, JPEG or TIFF file format 
and then transmitted to remote recipients simultaneously as an e-mail attachment.

When you send an e-mail to someone using this MFP it uses Simple Mail Transfer Protocol 
(SMTP) to transfer your outgoing e-mails to your SMTP mail server, and then send these 
e-mails to your recipients through the internet.

Setting up an SMTP Server

This section explains setting up a server.

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Network Menu and press Enter.

5. Using the Down arrow key, scroll to Mail Server Setup and press Enter.

6. Press Enter to select SMTP server and press Enter.

NOTE
1. DHCP server: With DHCP (Dynamic Host Configuration Protocol), a host 

can automatically be given a unique IP address each time it connects to a 
network-making IP address management an easier task for network 
administrators. If the DHCP server is available from your network, you do 
not need to enter TCP/IP, subnet mask, gateway, and DNS information. 
Instead, this information will be automatically given for the MFP.

2. IP Address: An IP (Internet Protocol) address uniquely identifies a host 
connection to an IP network. System administrator or network designer 
assigns the IP address. The IP address consists of two parts, one 
identifying the network and the one identifying your node. The IP address 
is usually written as four numbers separated by periods. Each number can 
be zero to 255. For example, 10.1.30.186 could be an IP address. 

3. SMTP: (Simple Mail Transfer Protocol) is the main communication protocol 
used to send and receive e-mail on the Internet.

4. DNS: (Domain Name System). The DNS server identifies hosts via names 
instead of IP addresses. If the DNS server is available on your network, 
you can enter the domain name instead of digits for your SMTP or POP3 
servers, such as Pegasus.com.tw instead of 120.3.2.23.

5. POP3: POP3 is the latest Post Office Protocol 3, this is a service that stores 
and serves e-mails for various client machines that are not connected to 
the Internet 24 hours a day. E-mails are held in POP3 until you log on.
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7. Enter your IP address.

8. To confirm, press the Enter key.

Scan to NetworkPC

Via the intranet with FTP (File Transfer Protocol) or CIFS (Common Internet File System). 
The MFP allows you to save scanned documents directly to a designated server or a 
personal computer on the network in a standard PDF, JPEG, or TIFF file format.

CIFS is the sharing system of Microsoft Windows. What is unique about this filing function 
is that it allows all corporate users to share one machine to send documents to each file 
folder on a designated server or individual computer.

The following settings or destinations must be defined by the system administrator before 
the MFP can be used to distribute any scanned document(s) on the network.

> Network and E-mail parameters: Defines the parameters for TCP/IP, SMTP, and 
POP3 protocols to send your scanned document to e-mail addresses.

> Filing destinations: Defines the protocols and destinations to send your scanned 
document to FTP servers or any personal computers on the network. 

CONFIGURATION

There are a number of configuration options available which allow you to change the 
scanner, fax (MB470/MB480) and printer settings to suit your own needs. There are three 
methods of configuring your MFP: 

1. From the MFP’s web page.

2. From the MFP’s Setup Tool utility.

3. From the MFP control panel.

For illustration purposes only, the configuration options shown are as accessed via the 
control panel.

NOTE
Numbers are entered using the keypad.

When a number is entered from the keypad, the number currently displayed 
is cleared and the number just entered is displayed as the first digit. When 
another number is entered, the first number entered moves to the left, and so 
on.

You can increment/decrement the digits using the UP/Down arrow keys.

NOTE
To cancel the IP address, press the Stop key until you exit the menu without 
saving the changes.

NOTE
1. If the system administrator has chosen DHCP, then the IP address of TCP/

IP, gateway, subnet mask, and DNS server will be automatically given.

2. When installing the MFP for the first time, it is recommended that the 
Administrator retain the default system settings. The settings can be 
customized at a later date, once you are familiar with the operation and 
functionality.
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...FROM THE WEB PAGE

Type the IP address of the MFP in the URL field of your browser and then press Enter. The 
MFP web page displays. For example: http://10.18.207.81    

 

NOTE
The Administrative Settings are blocked by a password. Refer to “Pre-
configuration information” on page 32.
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...FROM THE SETUP TOOL 

If you have not already done so, install the setup tool as described in “MFP Setup tool - 
Windows only” on page 21.   

...FROM THE CONTROL PANEL

1. Press the Down arrow key (1) on the control panel until Menu is highlighted, then 
press Enter (2).

2. Press the Down arrow key (1) until Admin Setup is highlighted, then press Enter (2).

NOTE
The Administrative Settings are blocked by a password. Refer to “Pre-
configuration information” on page 32.

NOTE
The Admin Setup option is blocked by a password. Refer to “Pre-configuration 
information” on page 32.

1

2
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Copy function

This is the default mode on Power up, with Access Control disabled. Use the Down arrow 
key to select other functions and Enter to select an option.

Default option (if relevant) is highlighted.

LEVEL 2 DESCRIPTION OPTIONS

Copies: Number of copies required (default 1) 1 to 99

100% Reduce/Enlarge copy A4->A5
Leg14->Let
Leg13.5->Let
Leg13->Let
A4->B5
Fit to page
100%
B5->A4
Let->Leg13
Let->Leg13.5
Let->Leg14
A5->A4
Custom

Letter Paper Supply Legal13, Legal13.5, 
Legal14, Letter, A4, A5, 
B5

Mixed Mode (Resolution) Mixed, Photo, 
HiRes.Mixed, 
HiRes.Photo

Density: 0 Density of print -3 ~ 0 ~ +3

Tray1 Input Tray:Selects cassette Tray or Manual feeder 
(MB460), or Multi Purpose Tray (MB470/MB480)

Tray 1, Tray2, 
Manual Feeder, MP Tray 

Off Collate:Sets collate function on or off On, Off

Off Duplex On, Off

1in1 N-up:Selects how many prints per page 1in1, 2in1, 4in1(Hor.), 
4in1(Ver.) 

E.E: Edge Erase: This sets the peripheral areas of the 
document to block out.

0.00, 0.25, 0.50, 0.75, 
1.00 inch
0, 6, 13, 19, 25mm

M.S-R: Margin Shift - Right: This sets the amount to shift the 
document image to the right.

0.00, 0.25, 0.50, 0.75, 
1.00 inch
0, 6, 13, 19, 25mm

M.S-B: Margin Shift - Bottom: This sets the amount to shift 
the document down.

0.00, 0.25, 0.50, 0.75, 
1.00 inch
0, 6, 13, 19, 25mm

ID Card Copy On, Off
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Scan/scan to function

Use the Down arrow key to select this function and Enter to select option.

E-mail 

LEVEL 2 DESCRIPTION OPTIONS

Check 
Address

Displays the default address (set by the 
administrator).

Reply to: Choose Email “Reply to” Address Book:

Screen Entry:

Number:

LDAP: Name

Address:

Method: OR/AND

Search: Address 
List

Destination Choose Address from: Address Book:

Screen Entry:

Number:

LDAP: Name

Address:

Method: OR/AND

Search: Address 
List

Subject Choose from the default subject list (set by the 
administrator) or enter a subject.

Subject List

Screen Entry

File Name A file name should be entered for the scanned 
images. 

This file name can be entered in Key Pad Mode. 

Up to 64 characters can be entered as text, except 
for the following;

\ / : * ? " < > |

N/A

Density Select density. -3, -2, -1, 0, 1, 2, 3

Document 
Size

Select document size. A4, Letter, Legal13, Legal13.5, 
Legal14

Color Select Select Color Color, B/W

File 
Format(Color)

Select file format. PDF, TIFF, JPEG

File 
Format(B/W)

Select file format. PDF, TIFF
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Network PC

PC

Fax function (MB470/MB480)

NOTE
The MFP must be connected to a Network server to enable Scan to Network 
PC to be set up.

Profiles can be created and managed using the machine’s web page or the MFP 
Setup Tool. 

LEVEL 2 DESCRIPTION OPTIONS

Profile If any profiles have been created the list will be 
displayed. Max 20 profiles can be created.

Color Select Select Color Color, B/W

LEVEL 2 DESCRIPTION OPTIONS

Email Scan to Email and save file

Folder Scan to PC based folder

Application Scan to Application1

Fax 
(MB470/
MB480)

Scan to Facsimile and save file

LEVEL 2 DESCRIPTION OPTIONS

Check Dest. Displays the selected destination fax number.

Fax No. Input a destination fax number.

Phone Book Select fax number from the phone book.

Mode Select the transmission resolution Standard

Fine

Extra Fine

Photo

Density Select density by entering a number in the range -3 to 
+3

-3 ~ 0 ~ +3

Document 
Size

Select document size A4

Letter, Legal13, 
Legal13.5, Legal14

Delayed 
Time

Select transmission time dd/mm/yyyy

hh:mm
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Menu function

LEVEL 2 ITEM DESCRIPTION/OPTIONS

View 
Information

Supplies Life Toner (n.nk) Remaining toner nnn%

Drum Remaining nnn%

Network IPv4 Address Self explanatory xxx.xxx.xxx.xxx

Subnet Mask Self explanatory xxx.xxx.xxx.xxx

Gateway 
Address

Self explanatory xxx.xxx.xxx.xxx

MAC Address Self explanatory xx.xx.xx.xx.xx.xx

NIC Program 
Version

Self explanatory xx.xx

NIC Default 
Version

Self explanatory xx.xx

System Serial Number Self explanatory xxxxxxxxxxxxxxxxxxxx
xxxxxx

Asset Number Self explanatory xxxxxxxx

Lot Number Self explanatory xxxxxxxxxxxxxxxxxxxx
xxxxxx

CU Version Self explanatory xx.xx

PU Version Self explanatory xx.xx.xx

Scanner 
Version

Self explanatory x.xx.xx

Fax Version 
(MB470/
MB480)

Self explanatory x.xx

Total Memory xx MB

Flash Memory xx MB[Fxx]

Print 
Information

Configuration Execute Prints out a report of the machine’s 
configuration

Network 
Information

Execute Prints out a report of the Network configuration

File List Execute

PCL Font List Execute

PS Font List 
(MB470/
MB480)

Execute

IBM PPR Font 
List

Execute

EPSON FX Font 
List

Execute

Error Log Execute

Demo Page DEMO1 Execute Prints a Demonstration 
page

MFP Usage 
Report

Execute Copies (1 to 99) Prints a full report of 
the machine usage
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Print 
Information 
cont.

Supplies Status 
Report

Execute Prints a report of the status of all consumables

Fax Activity 
Report (MB470/
MB480)

Execute

Fax Protocol 
Dump (MB470/
MB480)

Execute

Print System 
Status

Execute

Admin Setup System Setup Access Control Enable/Disable

Power Save Time 1/5/15/30/60/120 
minutes

Return to Stand-by 
Time

20/40/60/120/180 
seconds

Default Mode Copy/Scan/Fax

Unit of Measure inch/mm

Date Format mm/dd/yyyy,
dd/mm/yyyy, 
yyyy/mm/dd

Report Full Print On/Off

Panel Contrast -10~0~+10

Near Life Status Enable/Disable

Network Menu Network Setup TCP/IP Enable/Disable

IP Version IPv4
IPv4 + IPv6

IPv6

NetBEUI Enable/Disable

NetBIOS over TCP Enable/Disable

Ether Talk Enable/Disable

IP Address Set Auto/Manual

IPv4 Address xxx.xxx.xxx.xxx

Subnet Mask xxx.xxx.xxx.xxx

Gateway Address xxx.xxx.xxx.xxx

DNS Server Primary xxx.xxx.xxx.xxx

DNS Server 
Secondary

xxx.xxx.xxx.xxx

WINS Server Primary xxx.xxx.xxx.xxx

WINS Server 
Secondary

xxx.xxx.xxx.xxx

Web Enable/Disable

Telnet Enable/Disable

FTP Enable/Disable
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Admin Setup 
cont.

Network Menu 
cont.

Network Setup 
cont.

SNMP Enable/Disable

Network Scale Normal/Small

Hub Link Setting Auto Negotiate/
100Base-TX Full/ 
100Base-TX Half/ 
10Base-T Full/
10Base-T Half

Factory Defaults Execute

Mail Server 
Setup

SMTP Server user defined

SMTP Port 25

SMTP Encryption None/SMTPS/
STARTTLS 

POP3 Server user defined

POP3 Port 110

POP Encryption None/POP3S/STARTTLS

Authentication 
Method

None/SMTP/POP

SMTP User ID user defined

SMTP Password user defined

POP User ID user defined

POP Password user defined

LDAP Server 
Setup

Server Settings LDAP Server: User 
defined

Port Number: 389

Timeout: 10~30~120

Max. Entries: 2~100

Search Root: User 
defined 

Attributes Name1: cn

Name2: sn

Name3: givenName

Mail Address: Mail

Additional Filter: User 
defined

Authentication Method: Anonymous/
Simple/Digest-MD5/
Secure Protocol

Encryption None/LDAPS/
STARTTLS

Secure PrtcSrv 
Setting

Domain

Printer Setup Copies 1 - 999

Duplex On/Off

LEVEL 2 ITEM DESCRIPTION/OPTIONS
Configuring your machine... > 43



Admin Setup 
cont.

Printer Setup 
cont.

Media Check Enable/Disable

X Dimension 86~210~216 millimeter

Y Dimension 140~279~297~356 millimeter

Resolution 600 dpi/600x1200 dpi/600x2400 dpi/
1200x1200 dpi (MB470/MB480)

Toner Save 
Mode

Enable/Disable

Default 
Orientation

Potrait/Landscape

Form Length 5~60~64~128 lines

Edit Size CassetteSize/Letter/Executive/Statement/
Legal14/Legal 13.5/Legal13/A4/A5/A6/B5/ 
Custom/Com-9 Envelope/Com-10 Envelope/
Monarch Envelope/DL Envelope/C5 Envelope/C6 
Envelope

Scanner Setup Email Setup Add “To” Address On/Off

Default File Name User defined

Subject List #00
#01
#02
#03
#04

Default From User defined

Separation Limit 1/3/5/10/30 
megabytes/No limit

Auto Trans. Report On/Off

Fax Setup 
(MB470/
MB480)

Clock 
Adjustment

dd/mm/yyyy
hh:mm

Use Up & Down arrow 
keys to set and Right 
arrow key to advance.

Basic Setup Service Bit On/Off

Country Code Select the country in 
which the MFP is 
situated.

Local Phone No. <enter>

Sender ID <enter>

MCF(Single Location) On/Off

MCF(Multi Location) On/Off

Error MCF On/Off

Image in MCF On/Off

H/Modem Rate 33.6 Kbps
28.8 Kbps
14.4 Kbps
9.6 Kbps
4.8 Kbps

TAD Mode Type1/Type2/Type3

Tel Priority Mode On/Off
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Admin Setup 
Cont.

Fax Setup 
(MB470/
MB480) cont.

Basic Setup 
cont.

CNG Detection On/Off

T/F Timer Prg. 20seconds, 35seconds

Remote Receive No. Off, 000, 111, 222, 
333, 444, 555, 666, 
777, 888, 999, ***, 
###

Ring Response 1 ring/ 5/10/15/20 
seconds

Speaker Volume Off/Low/Middle/High

Soft Ringer Volume Off/Low/Middle/High

DRD Type Type1/ Type2/ Type3/ 
Type4

Fax Line Setup Redial Tries 0 ~ 10 tries

Redial Interval 1 ~ 6 minutes

Dial Tone Detection On/Off

Busy Tone Detection On/Off

MF(Tone)/DP(Pulse) DP/MF

PCL Setup Font Source Resident/Resident2/
Downloaded

Font Number I0/C1/S1

Font Pitch 0.44 ~ 10.00 ~ 99.99 
CPI

Symbol Set Available sets

A4 Print Width 78/80 column

White Page Skip On/Off

CR Function CR/CR + LF

LF Function LF/LF + CR

Print Margin Normal/1/5 inch/1/6 
inch

Pen Width Adjust On/Off

Tray ID#:
           PCL MNID 1 ~ 2 ~ 59

           PCL T0ID 1 ~ 4 ~ 59

           PCL T1ID 1 ~ 59

IBM PPR Setup Character Pitch 10/12/17/20 CPI/
Proportional

Font Condense 12CPI to 20CPI

12CPI to 12CPI

Character Set SET-2/SET-1

Symbol Set Available Sets

Letter O Style Enable/Disable

Zero Character Normal/Slashed

LEVEL 2 ITEM DESCRIPTION/OPTIONS
Configuring your machine... > 45



Admin Setup 
Cont.

IBM PPR Setup cont. Line Pitch 6 LPI/ 8 LPI

White Page Skip On/Off

CR Function CR/CR + LF

LF Function LF/LF + CR

Line Length 80/136 column

Form Length 11/11.7/12 inch

TOF Position 0.0 ~ 0.1 ~ 1.0 inch

Left Margin 0.0 ~ 0.1 ~ 1.0 inch

Fit to Letter Enable/Disable

Text Height Same/Diff

EPSON FX Setup Character Pitch 10/12/17/20CPI/
Proportional

Character Set SET-2/SET-1

Symbol Set Available sets

Letter O Style Enable/Disable

Zero Character Normal/Slashed

Line Pitch 6 LPI/8 LPI

White Page Skip On/Off

CR Function CR/CR + LF

Line Length 80/136 column

Form Length 11/11.7/12 inch

TOF Position 0.0 ~ 0.1 ~ 1.0 inch

Left Margin 0.0 ~ 0.1 ~ 1.0 inch

Fit to Letter Enable/Disable

Text Height Same/Diff

PS Setup (MB470/MB480) L1 Tray TYPE1/TYPE2

Parallel Protocol ASCII/RAW

USB Protocol ASCII/RAW

Network Protocol ASCII/RAW

Memory Setup Receive buffer size Auto/0.1/0.2/0.5/1/2/
4 MB

Resource Save 
(MB470/MB480)

Auto/Off/0.1/0.2/0.5/
1/2/4 MB

Change Password Select “New password” and enter

Verify Password

Settings Save Settings Execute

Reset Settings Execute

Printer Menu Tray 
Configuration

Manual feed 
(MB460)

On/Off
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Printer Menu 
Cont.

Tray 
Configuration

cont.

Paper Feed Tray1/Tray2/MP Tray

Auto Tray 
Switch

On/Off

Tray Sequence Down/Up/Paper Feed Tray

MP Tray Usage 
(MB470/
MB480)

When Mismatching/Do not use

Tray1 Config Paper Size A4/A5/B5/Legal14/
Legal13.5/Legal13/
Letter/Executive/
Statement/Custom

Media Type Plain/Letterhead/
Bond/Recycled/
Cardstock/Rough

Media Weight Light/Medium Light/
Medium/ Medium 
Heavy/ Heavy

Tray2 Config Paper Size A4/A5/B5/Legal14/
Legal13.5/Legal13/
Letter/Executive/
Custom

Media Type Plain/Letterhead/
Bond/Recycled/
Cardstock/Rough

Media Weight Light/Medium Light/
Medium/ Medium 
Heavy/ Heavy

MP Tray Config 
(MB470/
MB480)

Paper Size A4/A5/A6/B5/Legal14/
Legal 13.5/Legal13/ 
Letter/ Executive/
Statement/Custom/
Com-9 Envelope/Com-
10 Envelope/Monarch 
Envelope/DL Envelope/
C5 Envelope/C6 

Media Type Plain/Letterhead/
Transparency/Labels/
Bond/Recycled/Card 
Stock/Rough

Media Weight Light/Medium Light/
Medium/ Medium 
Heavy/ Heavy

Manual Feeder 
Config (MB460)

Paper Size A4/A5/A6/B5/Legal14/
Legal13.5/Legal13/
Letter/Executive/
Statement/Custom/
Com-9 Envelope/Com-
10 Envelope/Monarch 
Envelope/DL Envelope/
C5 Envelope/C6 
Envelope

Media Type Plain/Letterhead/
Transparency/Labels/
Bond/Recycled/Card 
Stock/Rough

LEVEL 2 ITEM DESCRIPTION/OPTIONS
Configuring your machine... > 47



Printer Menu 
Cont.

Tray Config 
cont.

Manual Feeder 
Config (MB460) 
cont.

Media Weight Light/Medium Light/ 
Medium/ Medium 
Heavy/ Heavy

Printer Adjust Manual Timeout Off/30/60/120/180/240/300 secs.

Low Toner Continue/Stop

Jam Recovery On/Off

Error Report On/Off

Start Up On/Off

Paper Black 
Setting

-2 ~ 0 ~ +2

Auto Continue On/Off

Timeout in Job Off/5/10/20/30/40/50/60/90/120/150/180/
210/240/270/300 seconds

Timeout Local 0/5~40~290/295/300 seconds

Timeout Net 0/5~90~290/295/300 seconds

Personality Auto/PCL/IBM PPR/EPSON FX/ PS3 
EMULATION(MB470/MB480)

Hex Dump Execute

Darkness -2 ~ 0 ~ +2

Cleaning Execute

X Adjust -2.00 ~ 0.00 ~ +2.00 millimeter

Y Adjust -2.00 ~ 0.00 ~ +2.00 millimeter

Duplex X Adjust -2.00 ~ 0.00 ~ +2.00 millimeter

Duplex Y Adjust -2.00 ~ 0.00 ~ +2.00 millimeter

Place Page Center/Left

Copy Menu Job Build Scanning On/Off

Copies 1-99

Reduce/Enlarge A4>A5 / Leg14>Let / Leg13.5>Let / 
Leg13>Let / A4>B5 / Fit to Page / 100% / 
B5>A4 / Let>Leg13 / Let>Leg13.5 /
Let>Leg14 /A5>A4 

Mode Mixed / Photo / HiRes.Mixed / HiRes.Photo

Density -3/-2/-1/0/+1/+2/+3

Input Tray Tray1/Tray2/Manual Feeder (MB460)/MP 
Tray(MB470/MB480)

Collate On/Off

Duplex On/Off

N-up 1in1/2in1/4in1(Hor.)/4in1(Ver.)

Edge Erase 0.00/0.25/0.50/0.75/1.00 inch
0/6/13/19/25mm

Margin Shift Right 0.00/0.25/0.50/0.75/1.00 inch
0/6/13/19/25mm
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Copy Menu 
cont.

Margin Shift Bottom 0.00/0.25/0.50/0.75/1.00 inch
0/6/13/19/25mm

Scanner 
Menu

Scan to Email Job Build 
Scanning

On/Off

Density -3/-2/-1/0/+1/+2/+3

Document size A4/Letter/Legal13/Legal13.5/Legal14

Color Select Color/B/W

Color Format File Format PDF/TIFF/JPEG

Compression Rate Low/Medium/High

Color Format 
cont.

Resolution 100/150/200/300 dpi

B/W Format Grayscale On/Off

File Format PDF/TIFF

Compression Rate G3/G4/Raw

Resolution 100/150/200/300/
400/600 dpi

Address Book Email Address #00 to #99

Group Address G00 to G19

Scan to Network PC Color Select Color/B/W

Fax Menu 
(MB470/
MB480) 

Auto Receive Fax
Manual
Tel/Fax
TAD
DRD

Mode Standard/Fine/Extra Fine/Photo

Density -3/-2/-1/0/+1/+2/+3

Document Size A4/Letter/Legal13/Legal13.5/Legal14

Phone Book Speed Dial/One 
touch dial

#00 to #99

Group Dial G00 to G09

System 
Shutdown

Shutdown Start Execute
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SETTING THE FAX FACILITY

INITIAL SET UP

The following parameters must be set before using the fax function on your MFP:

> Date and time

> Country code

> Local Phone No.

> Sender ID

There are other parameters that can be adjusted to suit your personal preferences later if 
required, refer to fax set up table for details (See “Advanced set up” on page 51.).

To set fax parameters: 

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password.
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Press Enter to select the Clock Adjustment menu.

6. Using the arrow keys and keypad, enter the time and date.

7. Press Enter to confirm.

8. Using the Down arrow key, scroll to Basic Setup and press Enter.

9. Using the Down arrow key, scroll to Country Code and press Enter.

10. Using the arrow keys, scroll to the country in which the MFP is situated and press 
Enter to confirm.

11. Using the Down arrow key, scroll to Local Phone No. and press Enter

12. Using the keypad or arrow keys, type in the local phone number press Enter to 
confirm.

13. Using the Down arrow key, scroll to Sender ID and press Enter.

14. Using the keypad or arrow keys and the on-screen keypad, type in the sender ID.

15. Highlight Done and press Enter.

16. Press the Left arrow key to exit the menu.

NOTE
Use the Right and Left arrow keys to move between digits.

NOTE
If required, set the dialling method for your region (Pulse or Tone). Refer to 
“MF(Tone)/DP(Pulse)” on page 45.

If connecting the machine through a private branch exchange (PBX) line, you 
must also specify a dial prefix to allow the machine to obtain an external line 
before dialling. Refer to “Connecting to a PBX” on page 52.
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ADVANCED SET UP

Your machine offers a multitude of features which reduce the time required for manual 
operation and make fax communications more efficient.

Adding a speed dial entry to the phone book 

The machine can hold up to 100 speed dial numbers in the phone book. To assign a speed 
dial number to the phone book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Fax Menu and press Enter.

3. Using the Down arrow key, scroll to Phone Book and press Enter.

4. Press Enter to select Speed Dial/One Touch Dial.

5. Using the arrow keys, scroll to the required speed dial entry position and press 
Enter.

6. Press Enter to select Fax.No.

7. Using the keypad, type in the destination fax number and press Enter.

8. Press Enter to select Name.

9. Using the keypad or arrow keys and the onscreen keypad, type in the name.

10. Highlight Done and press Enter.

11. Using the Down arrow key, scroll to Done and press Enter to confirm and add your 
entry to the phone book.

12. Press the Left arrow key to exit the menu.

Adding a group entry to the phone book

The machine can hold up to 10 group dial settings.

To add a new group dial number to the phone book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Fax Menu and press Enter.

3. Using the Down arrow key, scroll to Phone Book and press Enter.

4. Using the Down arrow key, scroll to Group Dial and press Enter.

5. Using the arrow keys, scroll to the required group dial entry position and press 
Enter.

6. Press Enter to select Speed Dial List.

7. Scroll through the list of speed dial entries and press Enter to mark (*). When all 
required entries are selected, press the Left arrow key. 

8. Press Enter to select Group Name.

NOTE
If the destination fax number has an “extension number”, press the “$” button 
three times to insert a pause (-) between numbers. The machine will enter a 
pause when dialling. See “ Character switching” on page

The maximum length of a number is 32 digits.

NOTE
The maximum length of a name is 16 characters.
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9. Using the keypad or arrows and the on-screen keypad, type in the name. 

10. Highlight Done and press Enter.

11. Using the Down arrow key, scroll to Done and press Enter to confirm and add your 
entry to the phonebook.

12. Press the Left arrow key to exit the menu.

Deleting a speed dial entry from the phone book

To delete a speed dial entry from the phone book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Fax Menu and press Enter.

3. Using the Down arrow key, scroll to Phone Book and press Enter.

4. Press Enter to select Speed Dial List/One Touch Dial.

5. Using the arrow keys, scroll to the required speed dial and press Enter.

6. Using the Down arrow key, scroll to Clear and press Enter.

7. Using the Up arrow key, scroll to Yes and press Enter.

8. Press the Left arrow key to exit the menu.

Deleting a group dial entry from the phone book

To delete a group dial entry from the phone book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Fax Menu and press Enter.

3. Using the Down arrow key, scroll to Phone Book and press Enter.

4. Using the Down arrow key, scroll to Group Dial and press Enter.

5. Using the arrow keys, scroll to the required group dial and press Enter.

6. Using the Down arrow key, scroll to Clear and press Enter.

7. Using the Up arrow key, scroll to Yes and press Enter.

8. Press the Left arrow key to exit the menu.

Connecting to a PBX

Private Branch Exchanges (PBXs) are private telephone systems used to route calls 
internally, for example, in a company. When dialling a telephone number, if a prefix is 
required to open an outside line, the line is connected to a PBX. If this MFP is going to be 
connected to a PBX, press the # key three times to insert a “-”, then type in the destination 
fax number. This will ensure the MFP waits until an outside line is available before dialling 
the rest of the number.

NOTE
The maximum length of a name is 16 characters.
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Automatic redial

You can set the fax to automatically redial if the initial fax transmission fails. The machine 
will redial on:

> Line busy

> No answer

> Communication error

To set auto-redial:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Using the Down arrow key, scroll to Fax Line Setup and press Enter.

6. Press Enter to select the Redial Tries.

7. Using the arrow keys, select the required number of redial attempts (between 0 and 
10), then press Enter to confirm.

8. Using the Down arrow key, scroll to Redial Interval and press Enter.

9. Using the arrow keys, select the required redial interval (between 1 and 6 minutes), 
then press Enter to confirm.

10. Press the Left arrow key to exit the menu.

Reception Mode

You can change the way your MFP handles incoming fax transmissions and telephone calls 
(if you have a telephone handset connected) depending on your office requirements. 
Choose from:

> Fax

> Manual

> Tel/Fax

> TAD

> DRD

To change the reception mode:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Fax Menu and press Enter.

3. Press Enter to select Auto Receive.

4. Using the arrow keys, select the required reception mode and press Enter.

5. Press the Left arrow key to exit the menu.
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Adding a telephone handset

If you want to add a telephone handset to your MFP, connect the line to the Tel socket (in 
certain countries it may be necessary to use a telephone plug adaptor).

You will also need to update the telephone settings to set the ring response:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Using the Down arrow key, scroll to Basic Setup and press Enter.

6. Using the Down arrow key, scroll to Ring Response and press Enter.

7. Using the arrow keys, select the required response setting (between 1 ring and 20 
seconds) and press Enter.

8. Press the Left arrow key to exit the menu.

MANAGING THE ADDRESS BOOK

The following section describes how to add/remove/modify e-mail addresses to/from the 
Address Book.

ADDING AN EMAIL ADDRESS ENTRY TO THE ADDRESS BOOK

The machine can hold up to 100 e-mail addresses in the address book. To assign a new 
email address to the address book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Press Enter to select Email Address.

5. Using the arrow keys, scroll to the required email address entry position and press 
Enter.

6. Press Enter to select Address.

7. Using the keypad or arrows keys and the on-screen keypad, type in the new email 
address.

8. Highlight Done and press Enter.

9. Press Enter to select Name.

NOTE
You must also set the reception mode to the appropriate setting. See 
“Reception Mode” on page 53.

NOTE
If the telephone handset is in use (off hook), dialling for speech purposes is 
not available using the MFP keypad or speed dial keys.

NOTE
The maximum length of address is 80 characters.
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10. Using the keypad or arrows keys and the on-screen keypad, type in the name.

11. Highlight Done and press Enter.

12. Using the Down arrow key, scroll to Done and press Enter to confirm and add your 
entry to the address book.

13. Press the Left arrow key to exit the menu.

DELETING AN EMAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete an email address entry from the address book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Press Enter to select Email Address.

5. Using the arrow keys, scroll to the required email address and press Enter.

6. Using the Down arrow key, scroll to Clear and press Enter.

7. Using the Up arrow key, scroll to Yes and press Enter.

8. Press the Left arrow key to exit the menu.

MODIFYING AN EMAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit an email address entry from the address book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Press Enter to select Email Address.

5. Using the arrow keys, scroll to the required email address and press Enter.

6. If required, press Enter to select Address. Update the details:

(a) Using the keypad or arrow keys and on-screen keypad, edit the email address.

(b) Highlight Done and press Enter.

7. If required, use the Down arrow key to scroll to Name and press Enter. Update the 
details:

(a) Using the keypad or arrow keys and on-screen keypad, edit the email name.

(b) Highlight Done and press Enter.

8. Using the Down arrow key, scroll to Done and press Enter.

9. Press the Left arrow key to exit the menu.

NOTE
The maximum length of name is 16 characters.

If you do not enter a name, this column remains blank.
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ADDING A GROUP ENTRY TO THE ADDRESS BOOK

The machine can hold up to 20 group addresses. To add a new group address to the address 
book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Using the Down arrow key, scroll to Group Address and press Enter.

5. Using the arrow keys, scroll to the required group address entry position and press 
Enter.

6. Press Enter to select Address List.

7. Scroll through the list of email address entries and press Enter to mark (*). When all 
required entries are selected, press the Left arrow key.

8. Press Enter to select Group Name.

9. Using the keypad or arrows keys and the on-screen keypad, type in the name.

10. Highlight Done and press Enter.

11. Using the Down arrow key, scroll to Done and press Enter to confirm and add your 
entry to the address book.

12. Press the Left arrow key to exit the menu.

DELETING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete a group address entry from the address book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Using the Down arrow key, scroll to Group Address and press Enter.

5. Using the arrow keys, scroll to the required group address and press Enter.

6. Using the Down arrow key, scroll to Clear and press Enter.

7. Using the Up arrow key, scroll to Yes and press Enter.

8. Press the Left arrow key to exit the menu.

MODIFYING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit a group address entry from the address book:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Scanner Menu and press Enter.

3. Using the Down arrow key, scroll to Address Book and press Enter.

4. Using the Down arrow key, scroll to Group Address and press Enter.

5. Using the arrow keys, scroll to the required group address and press Enter.

6. If required, press Enter to select Address List. Update the details:

NOTE
The maximum length of a name is 16 characters.

If you do not enter a Group name, Group name column remains blank. 
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(a) Using the arrow keys, scroll through the list and modify as required. Press Enter 
to remove any address from the group listing; the “*” will be removed from the 
address.

(b) Press the Left arrow key to exit the list.

7. If required, use the Down arrow key to scroll to Group Name and press Enter. Update 
the details:

(a) Using the keypad or arrow keys and on-screen keypad, edit the email name.

(b) Highlight Done and press Enter.

8. Using the Down arrow key, scroll to Done and press Enter.

9. Press the Left arrow key to exit the menu.
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ACCESS CONTROL
The operation and functionality of this machine can be limited to authorised personnel only 
by the simple introduction of a 4-9 digit PIN (Personal Identification Number). This is known 
as Access Control. The greater the number of digits in the PIN - the more secure it is.

Your MFP supports the following PIN types:

> Administrator PIN; This is the PIN for the system administrator(s).

If a PIN is registered as an administrator, the Admin password entry screen is 
displayed, and when an Admin password is entered, it will be authenticated as an 
administrator.

> User PIN; This is PIN for general users.

If a PIN is registered as a general user, the function selection screen is displayed, also 
after PIN entry, the function selection screen is displayed.

After using the machine, you will be expected to log out. Leaving the machine in access 

control mode will render the machine not usable by unauthorised users.

ENABLING ACCESS CONTROL

Access Control Enable/Disable is switched in Menu > Admin Setup > System Setup > 
Access Control.

If your administrator has enabled access control on your machine, it will automatically start 
up in access control mode. You will not be able to use it until you have provided valid login 
information.

With Access Control set to enable, the display reverts to the System Setup screen 
immediately following the setting change. If one of the functions such as Print, Fax Send 
or PC Scan is running, the display will only revert to the System Setup screen when the 
task has been completed.

LOGGING IN 
1. If the Enter PIN screen is displayed, use the keypad to enter your PIN.

2. Press Enter (or the Start button) to confirm.

3. At the Enter Password screen, use the on-screen keypad to enter your password.

4. Use the Up arrow key to highlight Done and press Enter to confirm.

LOGGING OUT

When you have finished using the machine, make sure you log out:

1. Using the Down arrow key, highlight Logout and then press Enter.

The Confirm Logout screen is displayed.

NOTE
A valid PIN consists of 4 to 9 digits.

Numbers entered are not displayed on-screen, they are replaced by “*”.

If the PIN entered in invalid, “Incorrect Password” is dispalyed for 3 seconds 
and the display reverts to the Enter the PIN screen.

NOTE
With Access Control enabled, Logout options are displayed in the Menu on the 
Mode Selection screen.
Access control > 58



2. Using the Down arrow key, highlight Yes and then press Enter to confirm. 

The display reverts to the Enter PIN screen.

OPERATION TIME-OUT

When the MFP control panel is left inactive for a prescribed length of time (Operation Time-
out), the display automatically reverts to the idle screen if Access Control is disabled.

If an error state occurs, Operation Time-out is disabled.

After Operation Time-out, the display automatically reverts to the Enter PIN screen if 
Access Control is enabled.

The length of the Operation Time-out depends on the setting in Menu Mode > Admin 
Setup > System Setup > Return to Standby Time.

NOTE
When the MFP control panel is left inactive for a prescribed length of time, the 
display automatically reverts to the Enter PIN screen if Access Control is 
enabled.
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OPERATION
With its intuitive control panel, this Multi Function Product (MFP) is designed to be easy to 
use. 

The following sections describe how to copy, fax (MB470/MB480), and scan your 
documents.

LOADING DOCUMENT(S)

This MFP can scan/copy/send/fax document(s) either in the ADF (Automatic Document 
Feeder) or on the glass. If you need to send multiple pages, load your papers in the ADF. 
The ADF can hold up to 50 pages at one time.

If you need to scan/copy/send/fax pages from books, newspaper clippings, or paper with 
wrinkles or curls, place them on the glass.

PLACING DOCUMENT(S) IN THE ADF

Before using the ADF, please make sure that your paper meets the following specifications:

> Document(s) can range in size from 5.8” x 8.2” (148mm x 210mm) - 8.5” x 
14”(216mm - 355.6mm)

> Document(s) can range in weight from 16 to 28 lbs (60 - 105 g/m2) and 11mm 
sheet thickness.

> Document(s) should be square or rectangular and in good condition (not fragile or 
worn).

> Document(s) should be free of curl, wrinkle, tears, wet ink, or punch holes.

> Document(s) should be free of staples, paper clips, paper sticky notes.

> Keep the glass clean and without any documents left on it.

1. If you have multiple pages, fan the pages to avoid paper jams. The ADF holds up to 
50 pages at one time.

NOTE
If Access Control has been enabled, you will first have to enter your Password/
PIN.

NOTE
The fax function is available only for MB470/MB480.

NOTE
> Glossy paper should not be used on the ADF.

> You cannot scan A6 document in the ADF.

> To transmit irregular types of document(s), place the document(s) on the 
glass or make a copy first and then transmit the copy instead.

1
2

3
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2. Place the document with the text face UP in the ADF and make sure that the top of 
each page is fed in first.

3. Adjust the Paper Guides (1) to centre the document in the ADF.

PLACING DOCUMENT(S) ON THE GLASS

1. Open the document cover.

2. Place your document with the text face DOWN on the glass and align the top of the 
page to the upper-left corner.

3. Close the document cover.

1
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COPYING

BASIC OPERATION

1. Place your document(s) with text face Up in the ADF or face Down on the glass.

2. Set your copying options as required. For further details refer to the following 
sections.

3. Then press the Start button.

ADVANCED OPERATION

Using the options available, you can alter the copy output to suit your needs:

1. Press Enter button.

2. Select required parameter with Down arrow key and press Enter.

3. Pressing Up and Down arrow keys, select value and press Enter.

Options are (factory default settings in bold text):

NOTE
Factory default setting is Copy mode.

NOTE
When using the ADF, in order to prevent paper jams, if you wish to cancel the 
copy process, press the Stop button once to stop the process and a second 
time to eject the paper.

MENU ITEM OPTIONS

Copies 1 - 99

Reduce/Enlarge A4>A5, Leg14>Let, Leg13.5>Let, 
Leg13>Let, A4>B5, Fit to page, 100%, 
B5>A4, Let>Leg13, Let>Leg13.5, 
Let>Leg14, A5>A4, Custom

Paper Supply Legal13, Legal13.5, Legal14, Letter, A4, A5, 
B5

Mode Mixed, Photo, HiRes.Mixed, HiRes.Photo

Density -3, -2, -1, 0, +1, +2, +3

Input Tray Tray1, Tray2(optional), Manual 
Feeder(MB460), MP Tray(MB470/MB480)

Collate On, Off

Duplex On, Off

N-up 1in1, 2in1, 4in1(Hor.), 4in1(Ver.)a

Edge_Erase 0.00 inch, 0.25 inch, 0.50 inch, 0.75 inch, 
1.00 inch or

0 mm, 6 mm, 13 mm, 19 mm, 25 mmb

M_SHIFT_R 0.00 inch, 0.25 inch, 0.50 inch, 0.75 inch, 
1.00 inch or

0 mm, 6 mm, 13 mm, 19 mm, 25 mmc

M_SHIFT_B 0.00 inch, 0.25 inch, 0.50 inch, 0.75 inch, 
1.00 inch or

0 mm, 6 mm, 13 mm, 19 mm, 25 mmd
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a. N-up can only be changed from 1in1 if paper size is set to A4 or Letter and documents are scanned 
from the ADF. Collate always defaults to “Off”. Reduce/Enlarge to “100%”. Reduce/enlarge to 
“100%,” Edge erase to “0mm (0.00in)” and Margin shift -Right/Bottom to “0mm (0.00in)”.

b. The setting displayed, mm or inch, depends on the setting in Admin Setup - System Setup - Unit of 
Measure in Menu Mode. If Edge Erase is set to other than “0 mm” or “0.00 in,” Reduce/Enlarge always 
defaults to “100%”, N-up to “1in1”, and Margin Shift - Right/Bottom to “0 mm (0.00 in)”.

c. Any parts of the image that do not fit on the paper as a result of this setting, are not printed. The 
setting displayed mm or inch, depends on the setting in Admin Setup - System Setup - Unit of 
Measure in Menu Mode. If Edge Erase is set to other than “0 mm” or “0.00 in,” Reduce/Enlarge always 
defaults to “100%”, N-up to “1in1”, and Margin Shift - Right/Bottom to “0 mm (0.00 in)”.

d. Any parts of the image that do not fit on the paper as a result of this setting, are not printed. The 
setting displayed mm or inch, depends on the setting in Admin Setup - System Setup - Unit of 
Measure in Menu Mode. If Edge Erase is set to other than “0 mm” or “0.00 in,” Reduce/Enlarge always 
defaults to “100%”, N-up to “1in1”, and Margin Shift - Right/Bottom to “0 mm (0.00 in)”.

4. Press the Left arrow key to return to the start menu.

Id Card Copy On, Off

MENU ITEM OPTIONS
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SCANNING

BASIC OPERATION

1. Place your document(s) with the text face up in the ADF or face Down on the glass.

2. Select Scan mode using the Down arrow button on the control panel.

3. Press Enter.

4. Press the Down arrow key and select the scan destination from the following 
options:

> Email

> Network PC

> PC

5. Set your scanning options as required. For further details refer to the following 
sections.

6. Then press the Start button.

SCAN TO EMAIL

1. Place your document(s) with text face Up in the ADF or face Down on the glass.

2. Using the Down arrow key, scroll to Scan and press Enter.

3. Press Enter to select Email.

4. Using the Up arrow key, scroll to Reply To and press Enter.

5. Set the reply address from either:

> Address Book - select from the address book entries

> Screen Entry - enter directly using the keypad

> Number - enter an address or group address number

> LDAP - select from a Lightweight Directory Access Protocol (LDAP) server

If prompted, select More and change address, otherwise select Done.

6. Using the Down arrow key, scroll to Destination and press Enter.

7. Set the destination address(s) from either:

> Address Book - select from the address book entries

> Screen Entry - enter directly using the keypad

> Number - enter an address or group address number

> LDAP - select from a Lightweight Directory Access Protocol (LDAP) server

If prompted, select More and add additional addresses, otherwise select Done.

8. Using the Down arrow key, scroll to Subject and press Enter.

9. Set the subject from either:

> Subject List

> Screen Entry

NOTE
When using the ADF, in order to prevent paper jams, if you wish to cancel the 
copy process, press the Stop/Cancel button once to stop the process and a 
second time to eject the paper.
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10. Using the Down arrow key, scroll to File Name and press Enter.

11. Using the keypad or arrow keys and the on-screen keypad, type in the file name.

12. Highlight Done and press Enter.

13. If required, adjust the density setting:

(a) Using the Down arrow key, scroll to Density and press Enter.

(b) Highlight the required setting and press Enter.

14. If required, adjust the document size:

(a) Using the Down arrow key, scroll to *A4 and press Enter.

(b) Highlight the required setting and press Enter.

15. If required, adjust the file format:

> If you are sending a colour file;

(i) Using the Down arrow key, scroll to Color Select (Color) and press 
Enter.

(ii) Highlight the required setting and press Enter.

> If you are sending a black and white file;

(i) Using the Down arrow key, scroll to Color Select (B/W) and press Enter.

(ii) Highlight the required setting and press Enter.

SCAN TO NETWORK PC

Before sending your document to a file server, profiles should be setup first to speed up 
the process. A profile contains a list of filing parameters such as your filing protocol, 
directory, file name and other scanning parameters. Add a new profile by either entering 
the machine’s web page or installing and starting the Network Setup Tool on the CD-ROM 
supplied.

1. Place your document(s) with text face Up in the ADF or face Down on the glass.

2. Using the Down arrow key, scroll to Scan and press Enter.

3. Using the Down arrow key, scroll to Network PC and press Enter.

4. The file server profile list is displayed. If no profiles exist, the profile list is blank.

5. Using the arrow keys, scroll to the required profile (filing destination) and press 
Enter.

6. Press the Start button.

SCAN TO PC

The scanner function can be controlled from either the MFP (Push Scan) or from the PC (Pull 
Scan).

NOTE
You can create up to 20 profiles.

NOTE
Ensure that the Actkey Utility is installed and set up first. Refer to “Actkey 
utility - Windows only” on page 22. 
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Push Scan

1. Place your document(s) with text face Up in the ADF or face Down on the glass.

2. Using the Down arrow key, scroll to Scan and press Enter.

3. Using the Down arrow key, scroll to PC and press Enter.

4. The Push Scan screen displays four options. Using the arrow keys, scroll to the 
required function and press Enter:

(a) Email

When the Email function is selected, the ActKey Utility executes PC scan in 
accordance with your settings for “Scan to Email”. The scanned image data is 
saved in the specified folder and is ready for the software to send as an 
attachment. Complete the data on screen and send. 

(b) Folder

When the Folder function is selected the Actkey Utility executes PC scan in 
accordance with your settings for “Scan to Folder”. The scanned image data is 
saved in the specified folder.

(c) Application

When the Application function is selected the Actkey Utility executes PC scan in 
accordance with your settings for “Scan to Application1”. The scanned image 
data is saved in the application specified by the Actkey Utility.

(d) Fax (MB470/MB480)

When the Fax function is selected, the Actkey Utility executes PC scan in 
accordance with your settings for Scan to PCFax. The scanned image data is 
saved in the specified folder and is ready for the software to send as an 
attachment. Complete the data on screen and send.

5. Press the Start button.
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Pull Scan 

Double click the Actkey Icon on your desktop. The Actkey console (below) will display.

The functions below, can now be controlled from the PC:

> Scan to Application1

> Scan to Application2

> Scan to Email

> Scan to Folder

> Scan to Fax (MB470/MB480)

Scan to “Application2” works exactly the same as scan to Application1, simply allowing an 
alternative application to be selected.

As the cursor passes over an icon, the parameters set for that icon appear in a text box, a 
single click will select that option.
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FAXING(MB470/MB480)

BASIC OPERATION

Searching the phone book

To search the contents of the phone book, you can either:

> Use the arrow keys to scroll through the list and highlight the required entry.

> Using the keypad to type in a search character, for example the first letters of the 
name. Destinations whose initial character matches the entered character appears 
on the screen.

Sending a Fax

1. Place your document(s) with text face Up in the ADF or face Down on the glass.

2. Using the Down arrow key, scroll to Fax and press Enter.

3. Enter the destination fax number by either:

(a) Selecting Fax No. and typing in the number using the numeric keypad.

(i) Press Enter.

(ii) At the continue prompt, select More to add additional numbers or Done to 
confirm.

(b) Selecting Phone Book and selecting the number from the phone book entries.

(i) Search the phone book entries, refer to “Searching the phone book” on 
page 68.

(ii) Repeat until all required entries are selected.

(iii) Press the Left arrow key to exit the list.

NOTE
Lists of Speed Dials and Group Dials that have been added to the Phone Book 
are displayed in the order Group Dial (G00~ G09) and Speed Dial/One Touch 
Dial (#00~#99).

NOTE
You can switch between numbers, upper-case/lower-case letters, and symbols 
by pressing the same key multiple times. When pressing multiple times, you 
must re-press the key within 2 seconds of the previous press.

Refer to Character switching see “Character switching” on page 15.

NOTE
You can type in a destination number in full or type in a speed dial or group 
dial number:

To enter a speed dial; press the “#” key and then enter the two-digit speed 
dial number, for example “#29”.

To enter a group dial; press the “*” key and then enter the one-digit group 
dial number, for example “*3”.

Fax number and ID registered in the selected dial number are displayed.
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4. If required, press the Up arrow key and scroll to Check Dest. to view /edit the list 
of fax numbers:

> Press Enter to remove any entry from the list (no longer displays * next to the 
entry).

> Press the Left arrow key to exit the list.

5. Press the Start button to send your document(s).

ADVANCED OPERATION

Changing the Fax Quality (Mode)

The machine is preset to “Standard”. If required, you can select Fine, ExtraFine, or Photo 
to improve fax quality.

To change fax quality:

1. Follow “Sending a Fax” process steps 1 to 4.

2. Using the Down arrow key, scroll to Standard and press Enter.

3. Using the Down arrow key, scroll to the required quality setting and press Enter.

4. Press the Start button to send your document(s).

Adjusting Density

The machine is preset to the “Normal” level of Density. If your original document comes 
with a lighter or darker contrast, you can improve the quality by adjusting the density 
setting.

To change density:

1. Follow “Sending a Fax” process steps 1 to 4.

2. Using the Down arrow key, scroll to Density:0 and press Enter.

3. Using the Down arrow key, scroll to the required density setting and press Enter.

4. Press the Start button to send your document(s).

Document Size

The machine is preset to “A4” size.

To change the document size:

1. Follow “Sending a Fax” process steps 1 to 4.

2. Using the Down arrow key, scroll to A4 and press Enter.

NOTE
If you wish to cancel faxing, press Stop to abort the operation.

Fax transmissions are sent in black and white only.

NOTE
After you have completed your fax operation, the machine will automatically 
return to the preset value.

NOTE
After you have completed your fax operation, the machine will automatically 
return to the preset value.
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3. Using the Down arrow key, scroll to the required document size and press Enter.

4. Press the Start button to send your document(s).

Fax Receiving

Your MFP is set to receive faxes automatically, if you wish to change the reception mode, 
refer to “Reception Mode” on page 53 for details.

Automatic fax receive (default mode)

When the MFP is in automatic fax receive mode:

> When ringing - Receiving start is displayed on Screen.

> While it is receiving a Fax - Fax Receiving, sender’s Fax. No., and the number of 
pages are displayed until the reception of data from all pages is complete.

> Upon completion of Fax Receiving - Sender’s Fax no., the total number of received 
pages and Receiving OK are displayed for 3 seconds, and the display changes to the 
Mode Selection screen.

> When the machine is printing Fixed images, the screen displays are the same as 
those for printing.

If fax receiving fails, an error message displays until you press the Stop button:

> If an error occurs while a fax is being received, fax communication-related errors are 
displayed.

> If an error occurs while a fax is printing, error messages displayed are the same as 
those in print mode.

Manual Receive

Upon receiving an incoming call, the MFP will ring until you press the Start button to receive 
the fax.

Refer to “Reception Mode” on page 53 for details on enabling manual receive mode.

Tel/Fax automatic switching

Telephone/Fax Mode (T/F): When incoming calls are a mixture of fax and telephone calls, 
your best choice is the Telephone/Fax Mode. In this mode, the machine detects whether 
the incoming call is a fax or voice call.

When the call is from another Fax machine, your machine will switch to fax mode and 
receive the message. When the call is a voice call, your machine will ring like a telephone. 
If you do not answer, your machine will switch back to fax mode to allow the calling party 
to manually send a fax.

Refer to “Reception Mode” on page 53 for details on enabling Tel/Fax mode.

NOTE
After you have completed your fax operation, the machine will automatically 
return to the preset value.

NOTE
Cancelling is disabled while the machine is receiving a fax.
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TAD interface

Telephone Answering Device Mode (TAD): Use this mode if you want the machine and 
telephone answering machine to share the same phone line. Like Telephone/fax mode, the 
TAD mode detects whether an incoming call is fax or voice call. Refer to “Adding a 
telephone handset” on page 54 for more information.

To set up TAD mode:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Using the Down arrow key, scroll to Basic Setup and press Enter.

6. Using the Down arrow key, scroll to TAD Mode and press Enter.

7. Select the appropriate setting; Type1, Type2, Type3.

8. Press the Left arrow key to exit the menu.

Refer to “Reception Mode” on page 53 for details on enabling TAD mode.

DRD interface

Distinctive Ring Detection Mode (DRD): This mode is programmed for the fax to answer 
only on a distinctive ring. You can have a single phone line to have two numbers with 
distinct rings, one for regular phone calls and one for fax. If the phone line is in use, and 
there is an incoming fax, the sender will receive a busy signal. 

To set up DRD mode:

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Using the Down arrow key, scroll to Basic Setup and press Enter.

6. Using the Down arrow key, scroll to DRD Type and press Enter.

7. Select the appropriate setting; Type1, Type2, Type3, Type4.

8. Press the Left arrow key to exit the menu.

Refer to “Reception Mode” on page 53 for details on enabling DRD mode.

Remote receiving

If you have an external telephone handset connected to your fax machine, you can instruct 
your fax machine to begin receiving by entering a three-digit code on your telephone 
keypad. This feature is useful when you answer a call on the external phone, but need to 
switch the line over to your fax machine.

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.
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5. Using the Down arrow key, scroll to Basic Setup and press Enter.

6. Using the Down arrow key, scroll to Remote Receive No. and press Enter.

7. Select the appropriate setting; Off, 000, 111, 222, 333, 444, 555, 666, 777, 
888, 999, ***, ###.

8. Press the Left arrow key to exit the menu.

Refer to “Remote Receive No.” on page 45.

PRINTING A FAX ACTIVITY REPORT

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Press Enter to select System Setup.

5. Using the Down arrow key, scroll to Report Full Print and press Enter.

6. Using the Up arrow key, scroll to On and press Enter.

7. Press the Left arrow key twice to exit the menu.

8. Using the arrow keys, scroll to Print Information and press Enter.

9. Using the Down arrow key, scroll to Fax Activity Report and press Enter.

10. Press Enter to execute.

PRINTING TRANSMISSION REPORTS

1. Using the Down arrow key, scroll to Menu and press Enter.

2. Using the Down arrow key, scroll to Admin Setup and press Enter.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press Enter.

4. Using the Down arrow key, scroll to Fax Setup and press Enter.

5. Using the Down arrow key, scroll to Basic Setup and press Enter.

6. Using the Down arrow key, navigate to the required report and press Enter. Choose 
from:

> MCF (Single Location) - this prints a transmission report after each fax.

> MCF (Multi Location) - this prints a summary report detailing which numbers 
were successful and any that failed.

> Error MCF - this prints a report after each failed fax transmission.

> Image in MCF - this includes an image of the fax on each transmission report.

7. Using the Up arrow key, scroll to On and press Enter.

8. Press the Left arrow key to exit the menu.
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SENDING A FAX FROM YOUR PC

1. From your application’s File menu, select Print.

2. In the Select Printer window, highlight the fax driver option.

3. Press the Preferences/Properties button to display the fax driver window.

4. On the Setup tab:

(a) Select the appropriate media size from the drop-down menu.

(b) Set the resolution to Fine, Normal or Fast.

(c) Set the orientation to Portrait or Landscape.

5. On the Cover Sheet tab:

(a) Set the cover sheet usage settings as appropriate.

(b) Select a cover sheet format.

6. On the Sender tab:

(a) Enter your name.

(b) Enter your fax number.

(c) If required select the Add an outside call number checkbox and enter Outside 
call number as appropriate.

NOTE
You must have the fax driver installed on your PC. Download the latest fax 
driver from www.okiprintingsolutions.com.
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7. On the Recipient tab:

(a) Click the Recipient...button.

(b) Select a fax number from the Phone book panel on the right hand side. Refer to 
“Adding fax numbers to the phone book” on page 75.

(c) Click the Add button to add this number to the recipient list.

(d) Repeat b and c as required to create the recipient list.

(e) If you need to remove a number from the recipient list, highlight the appropriate 
name and then click the Delete button.

(f) Once you have completed your list, click the OK button to close the Select 
Recipients window.

8. Click the OK button to close the fax driver window.

9. Click the OK button to start sending your fax.
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ADDING FAX NUMBERS TO THE PHONE BOOK

To add a fax destination number to the phonebook:

1. From your application’s File menu, select Print.

2. In the Select Printer window, highlight the fax driver option.

3. Press the Preferences button to display the fax driver window.

4. Click the Phone book... button.

The phone book screen displays.

5. Select FAX number -> New (Fax number).

6. Type in the fax number destination Name.

7. Type in the required FAX number.

8. If required, type in a Comment.

9. Click the OK button to save.

ADDING NEW GROUPS NUMBERS TO THE PHONE BOOK

To add a new group to the phone book:

1. From your application’s File menu, select Print.

2. In the Select Printer window, highlight the fax driver option.

3. Click the Preferences button to display the fax driver window.

4. Click the Phone book... button.

The phone book screen displays.

5. Select Fax number -> New (Group).

6. Type in the Group name.

7. if required, type in a Comment.
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8. Add recipients to the group list:

(a) Select a fax number from the Phone book panel on the right hand side.

(b) Click the Add -> button to add this number to the group list.

(c) Repeat steps a and b as required to create the group list.

(d) If you need to remove a number from the recipient list, highlight the appropriate 
name and then press the <- Delete button.

9. Once you have completed your list, click the OK button to close the New Group 
window.

IMPORTING AND EXPORTING FAX NUMBERS

By using the import, export functions, you can manage fax numbers in a phonebook 
created on another computer.

1. In Windows:

XP: select Start > Control Panel > Printer and Other Hardware > Printers and 
Faxes.

Server 2003: select Start > Printers and Faxes.

2000: select Start > Settings > Printers.

2. Right-click your machine icon and select Printer Preferences.

3. In the Setup tab, click the Phone Book button.

4. From the pull-down menu, click Tool > Export.

5. In the Export File screen, enter a name for the file and click the Save button. The 
phonebook is saved.

6. Import the saved phonebook file to the other computer:

(a) In the fax driver installed on the computer that the phone book file was 
imported, start the phonebook in the same way, and click Tool > Import in the 
menu.

(b) In the Import File screen, select a phone book file to import. When the Open 
button is clicked, data is imported to the phone book.

NOTE
Maximum 100 recipients in any one group.

NOTE
You can add a new fax number directly by clicking the New (FAX number)... 
button and adding an entry to the phone book panel.

NOTE
Registration of groups cannot be exported. (Destinations included in the group 
are exported.)

If the same name is already included in the phonebook of the fax driver to 
import, it is skipped.
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PRINTING SETTINGS IN WINDOWS
Your printer’s operator panel menus provide access to many options.

The Windows printer driver also contains settings for many of these items. Where items in 
the printer driver are the same as those in the operator panel menus, and you print 
documents from Windows, the settings in the Windows printer driver will override those 
settings in the operator panel menus.

PRINTING PREFERENCES IN WINDOWS APPLICATIONS

When you choose to print your document from a Windows application program a Print 
dialogue box appears. This dialogue usually specifies the name of the printer on which you 
will print your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains a short list of the printer 
settings available in the driver, which you can choose for this document. The settings 
available from within your application are only those which you may want to change for 
specific applications or documents. Settings you change here will usually only last for as 
long as the particular application program is running.

PCL EMULATION

Setup tab

1. Paper size should be the same as the page size of your document (unless you wish 
to scale the printout to fit another size), and should also be the same as the size of 
paper you will feed into the printer.

2. You can choose the source of the paper to feed, which may be Tray 1 (the standard 
paper tray), Manual (MB460) or the Multi Purpose Tray (MB470, MB480), Tray 2 (if 
you have the optional second paper tray installed). You can also click on the 
appropriate part of the screen graphic to select your preferred tray.

3. A variety of document finishing options can be selected, such as normal one page 
per sheet, or N-up (where N can be 2 or 4) for printing scaled down pages at more 
than one page per sheet.

4. Under 2-sided Printing, you can choose from auto or manual. Under manual 2-sided 
Printing you can choose to print on one side of a sheet only or to use 2-sided 
printing (duplex printing). Your printer allows you to carry out manual duplex 
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printing, meaning you must pass the paper through the printer twice. For more 
information, see “2-sided printing” on page 85. The Duplex Help button also offers 
guidelines on how to carry out manual duplex printing.

5. If you have changed some printing preferences before and saved them as a set, you 
can recall them to avoid having to set them individually each time you need them.

6. A single on-screen button restores the default settings.

Job options tab

1. The output resolution of the printed page can be set as follows.

> The ProQ1200 setting for MB460 prints at 600 X 2400dpi. This setting requires 
the most printer memory and takes the longest to print. Your printed pages can 
be scaled to fit larger or smaller stationery. It is the best option for printing 
photographs.

> The High Quality setting prints at 600 X 1200dpi for MB460 and 1200 x 1200dpi 
for MB470 and MB480 is the best option for printing vector objects such as 
graphics and text. 

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs.

> The Draft setting prints at 300 x 300dpi and is suitable for printing draft 
documents that contain mainly text. You can select Toner Saving to save toner for 
some print jobs.

2. Page orientation can be set to either portrait (tall) or landscape (wide). Both views 
can be rotated by 180 degrees. 

3. You can print watermark text behind the main page image. This is useful for marking 
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do 
not want to use pre-printed stationery, you can create your own using Overlays. For 
more information on Overlays and Macros refer to “Overlays and Macros (Windows 
only)” on page 103. The Overlays button also offers guidelines on how to carry out 
manual duplex printing.

4. In Raster (bitmap) mode, processing of the page image is done in the computer 
leaving little processing for the printer to do, although the file size may be large. In 
Vector mode, file sizes may be smaller and so transmission over a network, for 
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example, may be faster. These effects are more pronounced for graphics printing 
than for text printing.

5. You can select up to 999 copies to print consecutively, although you will need to top 
up the paper tray during such a long print run.

6. Your printed pages can be scaled to fit larger or smaller stationery, within a range of 
25% to 400% of the original size.

7. A single on-screen button restores the default settings.

Image tab

1. Dithering produces an intermediate greyscale by adjusting the combination of dots 
used in printing. Selecting a setting determines the degree of detail with which a 
graphics image will be printed. Mesh determines that a screen of dots is used for 
dithering while Line Art determines that an array of lines is used for dithering.

2. Select dithering texture by setting the size of dots used in the halftone screen.

3. Set this control to print greyscale effects in black without dithering. Select the 
check-box to disable greyscale printing or de-select the check-box to enable 
greyscale printing.

4. You can manually adjust lightness (the higher the setting the lighter the print) and 
contrast (the higher the setting the greater the contrast).

5. A single on-screen button restores the default settings.

SETTING FROM WINDOWS CONTROL PANEL

When you open the driver properties window directly from Windows, rather than from 
within an application program, a somewhat more extensive range of settings is provided. 
Changes made here will generally affect all documents you print from Windows 
applications, and will be remembered from one Windows session to the next.
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General tab

1. This area lists some of the main features of your printer, including optional items.

2. This button opens the same windows as described earlier for items which can be set 
from within application programs. Changes you make here, however, will become 
the new default settings for all Windows applications.

3. This button prints a test page to ensure that your printer is working.

Advanced tab

1. You can specify which times of day your printer will be available.

2. Indicates current priority, from 1 (lowest) to 99 (highest). Highest priority 
documents will print first.

3. Specifies that documents should be spooled (stored in a special print file) before 
being printed. The document is then printed in the background, allowing your 
application program to become available more quickly. Options follow:

This specifies that printing should not start until the last page has been spooled. If 
your application program needs a lot of time for further computation in the middle of 
printing, causing the print job to pause for more than a short period, the printer could 
prematurely assume that the document has finished. Selecting this option would 
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prevent that situation, but printing will be completed a little later, as the start is 
delayed.

This is the opposite choice to the one above. Printing starts as soon as possible after 
the document begins spooling.

4. This specifies that the document should not be spooled, but printed directly. Your 
application will not normally be ready for further use until the print job is complete. 
This requires less disk space on your computer, since there is no spool file.

5. Directs the spooler to check the document setup and match it to the printer setup 
before sending the document to print. If a mismatch is detected, the document is 
held in the print queue and does not print until the printer setup is changed and the 
document restarted from the print queue. Mismatched documents in the queue will 
not prevent correctly matched documents from printing.

6. Specifies that the spooler should favour documents which have completed spooling 
when deciding which document to print next, even if completed documents are lower 
priority than documents which are still spooling. If no documents have completed 
spooling, the spooler will favour larger spooling documents over shorter ones. Use 
this option if you want to maximise printer efficiency. When this option is disabled 
the spooler chooses documents based only on their priority settings.

7. Specifies that the spooler should not delete documents after they are completed. 
This allows documents to be re submitted to the printer from the spooler instead of 
printing again from the application program. If you use this option frequently it will 
require large amounts of disk space on your computer.

8. Specifies whether advanced features, such as pages per sheet, are available, 
depending on your printer. For normal printing keep this option enabled. If 
compatibility problems occur you can disable the feature. However, these advanced 
options may then not be available, even though the hardware might support them.

9. This button provides access to the same setup windows as when printing from 
applications. Changes made via the Windows Control Panel become the Windows 
default settings.

10. You can design and specify a separator page that prints between documents. This is 
particularly useful on a shared printer to help each user find their own documents in 
the output stack.

Device options tab

In this window you can select which optional upgrades are installed on your printer. See 
the chapter entitled “Installing options”.
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PS EMULATION (MB470/MB480)

Layout tab

1. Page orientation can be set to portrait (tall), landscape (wide) or landscape rotated 
by 180 degrees.

2. Print on both sides (duplex printing) can be set to long edge or short edge of the 
document.

3. Printed page order can be set as front to back or back to front of the document.

4. Set the number of pages to be printed on a single sheet. You can also set it to print 
a booklet.

5. Click the Advanced button to be able to set further document options as follows:

(a) Select the required printed paper size.

(b) You can substitute another font for TrueType Font.

(c) You can set other document options as required, including PostScript options 
and printer features.
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Paper/Quality tab

You can set the paper source or leave it as automatic selection and by using the Advanced 
button you have access to the same set of options as described above for the Layout Tab.

Job options tab

1. The output resolution of the printed page can be set as follows.

> The High Quality setting prints at 1200 x 1200dpi for MB470 and MB480 and is 
the best option for printing vector objects such as graphics and text.

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs. 
You can select Toner Saving to save toner for some print jobs.
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2. You can print watermark text behind the main page image. This is useful for marking 
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do 
not want to use pre-printed stationery, you can create your own using Overlays. For 
more information on Overlays and Macros refer to “Overlays and Macros (Windows 
only)” on page 103. The Overlays button also offers guidelines on how to carry out 
manual duplex printing.

3. You can select up to 999 copies to print consecutively, although you will need to top 
up the paper tray during such a long print run.

4. Your printed pages can be scaled to fit larger or smaller stationery.

5. Using the Advanced button gives you access to the facility to set mirror image 
printing and negative image printing.

6. A single on-screen button restores the default settings.

SETTINGS FROM THE CONTROL PANEL

The main tabs are the General Tab, Advanced Tab and Device Settings Tab. The 
General and Advanced tabs are the same as for PCL emulation described earlier.

Device settings tab

1. You can set the desired paper sizes in each of the available paper feed trays.

2. You can make a variety of font settings depending on your application.

3. You can set which optional upgrades are installed on your printer. See the chapter 
entitled “Installing options”.
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2-SIDED PRINTING 
The duplex unit adds the function of two-sided printing, using less paper and making large 
documents easier to handle. It also enables booklet printing, which uses even less paper.

The duplex unit slides straight into the rear of the printer and requires no tools to install.

This machine has the option of Auto Duplex and Manual Duplex printing.

AUTO DUPLEX PRINTING

This option provides automatic two-sided printing only for Letter, A4, Legal 13, 13.5 and 
14 and Custom paper sizes, using paper stocks from 75 - 105g/m2. 

To carry out Auto Duplex Printing:

1. Select File -> Print and click the Properties button. 

2. Select the input tray (Tray1, Tray2 (optional), Multi Purpose Tray) from the Source 
drop down.

3. In the Duplex printing drop down menu, select either Long Edge (Auto) or Short 
Edge (Auto) according to your printing preferences. 

4. If you require further information, click the Duplex Help button.

5. Click the Print button.

NOTE
The steps in the process relate to Windows XP PCL. Other operating system 
windows may appear slightly different, but the principles are the same.
Printing settings in windows > 85



MANUAL DUPLEX PRINTING USING THE PAPER TRAY (WINDOWS ONLY) 

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the machine 
twice. You can carry out 2-sided printing using the Paper Tray (for paper sizes see 
“Cassette trays” on page 24) or the Multi Purpose Tray (for paper sizes see “Multi purpose 
tray” on page 24). 

1. Ensure that there is enough paper in the Paper Tray to carry out the print job. 

2. Select File -> Print and click the Properties button. 

3. Select the Multi Purpose Tray/Manual from the Source drop down.

4. In the 2-sided printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. If you require further 
information, click the Duplex Help button. Then, Click the Print button. 

NOTE
Manual Duplex printing is available only for Windows PCL Driver.

NOTE
You cannot use A6 paper size for printing from Tray 1 or Tray 2 (option).
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5. Every second page (1) of your document is printed first. When this is complete, a 
message appears on screen prompting you to take the paper, flip it and replace it in 
the Paper Tray. 

6. Open the Paper Tray (2). 

7. Take the printed paper from the Output Stacker (3) and place it in the Paper Tray, 
ensuring that the printed side is facing up and the bottom of the page facing into the 
machine (4). 

8. Close the Paper Tray and press the Start button. The message window should 
disappear from your screen and the document finishes printing the remaining pages 
of your document. 

NOTE
You must press the Start button to start the printing for other side. The default 
time is set to one minute, failing which, the data is deleted and not printed.
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MANUAL DUPLEX PRINTING USING THE MULTI PURPOSE TRAY 

1. Position the paper guides on the Multi Purpose Tray according to the paper size.

2. Place paper one sheet at a time in the Manual Feed Tray. The paper is automatically 
gripped in position.

3. Select File -> Print to display the Print dialog box.

4. Click the Properties button. 

5. Select the Multi Purpose Tray from the Source drop down.

6. On the 2-sided printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. If you require further 
information, click the Duplex Help button.

7. When every second page has printed, take the paper from the output stacker.

8. Set the paper one page at a time in the Multi Purpose Tray with the printed side 
facing down and the top of the page facing into the machine. Ensure that the paper 
is gripped in place.

9. Press the Start button. The remaining pages of your document print on the blank 
side of the paper, one sheet at a time as you feed it into the Multi Purpose Tray.

NOTE
> When using the Multi Purpose Tray on MB460, feed one sheet at a time. 

> For loading instructions see “Multi purpose tray” on page 30.
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PRINTER SETTINGS IN MAC OS X
The information in this section is based on Mac OS X Tiger (10.4). Other versions may 
appear slightly different, but the principles are the same.

PCL EMULATION

SETTING PRINTING OPTIONS

You can choose your printer and select options for how you want your documents to print 
from the Print dialog box.

To set your printer options:

1. Open the document you want to print.

2. To change the paper size or page orientation, select File > Page Setup. For a 
description of each option, see “Page setup options” on page 91.

3. Close the Page Setup dialog box.

4. Select File > Print.

5. Select your printer from the Printer drop-down menu.
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6. To change any printer driver settings, select the required options from the Settings 
drop-down menu. You can select more options from the Copies & Pages menu. For a 
description of these options, see “Print Options” on page 92.

7. Click the Print button.

SETTING PRINTING OPTIONS - SAVING DRIVER SETTINGS

You can save a set of printer driver options to use for future documents.

1. Open the document you want to print.

2. To change the paper size or page orientation, select File > Page Setup.

3. Select Save As Default from the Settings drop-down menu.

4. Select File > Print.

5. To save the current printer driver settings as a preset, select Save As from the 
Preset menu.

6. Enter a name for your preset and click OK.
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CHANGING THE DEFAULT PRINTER AND PAPER SIZE

The following steps describe how to change your default printer and the paper size options.

1. Select Apple menu > System Preferences.

2. Click the Print & Fax icon.

3. Select your printer in the Selected Printer in Print Dialog drop-down menu.

4. Select your required paper size in the Default Size in Page Setup drop-down menu.

PAGE SETUP OPTIONS

This section provides a description of the page setup options available to you.

Page attributes

You can select Save As Default to use the current Page Setup settings as a standard for all 
documents.

Format for

Allows you to select your printer model before changing options such as Paper Size and 
Orientation.

Paper size

Select a paper size to match your documents and the paper loaded in the printer. The paper 
margin is 4.2mm at all edges. To specify your own paper sizes, select Manage Custom 
Sizes...

Scale

You can scale documents up or down to fit onto different paper sizes. To fit your document 
on a specific paper size, select Options in the Paper Handling drop-down menu in the 
Print Options dialog box (see “Print Options” on page 92).

Orientation

You can select a portrait or landscape option. When using landscape, you can rotate the 
document 180 degrees.
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PRINT OPTIONS

COPIES & PAGES

Copies 

This option allows you to enter the number of copies to print. If you select Collate, all pages 
of the document will print before the next copy prints.

Pages

You can select whether to print all pages of a document or just a section of it.

Layout

Pages per sheet

You can shrink multiple pages and print them on a single sheet of paper. For example, 
choosing 4-up will tie four of your document’s pages across a single sheet of paper. 

You can control the order in which the documents are tiled and also choose to surround 
each document page with a border.
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Two-sided

You cannot use the two sided printing options in this panel. Use the options in “Duplex” on 
page 94 instead.

Scheduler

This option lets you choose whether to print your document immediately, or defer printing 
until later. You can also assign a priority to a print job.

These features are useful if you are printing large documents that take a long time to print.

PAPER HANDLING

Page order

You can choose to print your document in the normal page order (1,2,3...) or reverse order 
(...3,2,1).
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Print

This option allows you to choose whether to print only odd or even number of pages. This 
is useful if you are using manual duplex for which you first print all odd pages, re-insert the 
paper in the printer and then print all even pages.

Destination paper size

Scale documents to fit on the size of paper in your printer. For example, you can take a 
document formatted for A3 and print it on A4 paper using an A4 printer.

COVER PAGE

Choosing a cover page may help you identify your printed document in a large pile of paper. 
This is useful in a busy office with many people sharing the printer.

DUPLEX

Using the duplex, you can print on both sides of the paper. 

Long Edge Binding prints pages that read like a normal book. Short Edge Binding prints 
pages that read like a notepad.
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Paper source

This option allows you to select the paper tray to use for your print job.

Print quality  

Use this option to select the print resolution. The ProQ1200 (MB460) and High Quality 
(MB470/MB480) setting produces the best graphic images, but these images take longer 
to print.

 MB460                     MB470/MB480   
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EFFECTS 

Dithering produces an intermediate greyscale by adjusting the combination of dots used in 
printing. Selecting a setting determines the degree of detail with which a graphics image 
will be printed. Mesh determines that a screen of dots is used for dithering while Line Art 
determines that an array of lines is used for dithering.

Select dithering texture by setting the size of dots used in the halftone screen. 

Adjust the brightness or contrast based on the original quality of the document.

PRINTER SETUP OPTIONS

PRINTER OPTIONS   

Density

Select the density from Lightest (-2) to Darkest (+2) depending on the quality of the 
original document.

 MB460                     MB470/MB480   
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Weight

Select the thickness or type of paper in the printer. It is important to set this correctly as 
it affects the temperature at which the toner is fused to the paper. For example, if you are 
printing on normal A4 paper, do not select Labels or Transparency as this may cause toner 
smearing and paper jam.

Toner Save

Toner Save uses less toner when printing your document. This is best suited to draft text 
documents as it lightens the print significantly.

Auto Tray Switch

If the printer runs out of paper in the current tray, the Auto Tray Switch automatically 
changes to a tray that has the same type of paper and continues printing.

Paper size check

Select Paper Size check if you want the printer to warn you when the document paper size 
is different from the paper in the printer.

A warning message is displayed and printing continues when you load the correct paper in 
the paper tray and press START. When this option is deselected, the printer uses the paper 
loaded in the selected tray regardless of the document size.

Feed manually from Multi-purpose tray (MB470/MB480)

Select this option if you want the printer to wait until you press the START button when 
feeding from the Multi-purpose Tray. This can be useful if printing envelopes.

PRINT CONTROL

If you are using the Windows Print Control Server software to manage printers, enter your 
assigned user name and ID. This information is sent to the printer with your print job and 
is recorded by the printer.
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SUMMARY

This option displays a summary of all selected print options for the current job.

PS EMULATION (MB470/MB480)

COPIES & PAGES

Refer to “Copies & Pages” on page 92. 

LAYOUT

Refer to “Pages per sheet” on page 92. 

The Two-sided option is used for Duplex printing. Long-edged Binding prints pages that 
read like a normal book. Short-edged Binding prints pages that read like a notepad.

SCHEDULER

Refer to “Scheduler” on page 93.

PAPER HANDLING

Refer to “Paper Handling” on page 93.
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COVER PAGE

Refer to “Cover page” on page 94.

ERROR HANDLING

Postscript errors

If an error occurs and stops the print job, you can use select the Print detailed report under 
Error Handling, which will print the error page in detail. This will help you identify the error 
and take suitable action.

Tray switching

If the printer runs out of paper in the current tray, the Auto Tray Switch automatically 
changes to a tray that has the same type of paper and continues printing.

By selecting Display alert, a pop-up box will display on your application if there is a 
mismatch between the tray settings and paper size settings.

PAPER FEED

If you want the first page of a document printed on a different media, you can load the 
special media in the Multi-purpose tray and select the first page to be printed by setting 
Multi-purpose tray as the source. The remaining pages of the document can be loaded in 
the cassette tray and you can set that as the paper source. The entire document will be 
printed in one print job.
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PRINTER FEATURES

Paper input options

Paper size check

Select Paper Size check if you want the printer to warn you when the document paper size 
is different from the paper in the printer. 

A warning message is displayed and printing continues when you load the correct paper in 
the paper tray and press Start. When this option is deselected, the printer uses the paper 
loaded in the selected tray regardless of the document size.

Media Type

Specify the appropriate weight and kind of paper you are using. Do not choose Label or 
Transparency when printing on plain paper. This will cause paper jam or print quality 
problems.

Multipurpose tray is handled as manual feed

Select this option if you want the printer to wait until you press the START button when 
feeding from the Multi-purpose Tray. This can be useful if printing envelopes.
Printer settings in Mac OS X > 100



Job options

Quality

Use this option to select the print resolution; 600 x 600dpi (normal printing), 1200 x 1200 
(choose this for high quality print). The high quality print resolution requires a larger 
amount of disk space and takes longer to print.

Toner saving 

Uses less toner when printing your document. This is best suited to draft text documents 
as it lightens the print significantly.

Page rotate

Select Page rotate to turn the text and images 180 degrees and point them across the 
length of the page.

Adjust ultra fine lines

If you are printing a drawing and want to emphasize the pen width of very fine lines, select 
this option to improve the appearance of the lines. However, in some applications, if this 
options is selected and you are printing barcodes, the spaces in the barcode becomes too 
narrow. De-selecting this option resolves this problem.

Summary

This option displays a summary of all selected print options for the current job.
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CANCELLING A PRINT JOB

You can cancel a print job from your software application, from the print queue or by using 
the STOP button on your printer.

PRINTING 
STATE

HOW TO CANCEL 

Document has not 
started printing

Try to cancel printing job within software 
application

Document is waiting 
in a print queue

Delete print job from Print Queue. You can access 
the print queue from the System Tray in Windows 
or the Print Center Queue in Mac.

Document has 
started printing

Press the STOP button on your printer. Any pages 
that are already moving through the printer will be 
printed. You will need to press STOP for each print 
job you wish to stop.
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OVERLAYS AND MACROS (WINDOWS ONLY)

WHAT ARE OVERLAYS AND MACROS?
If you would like to print on special stationery, such as forms and letterhead, but do not 
want to use pre-printed stationery, you can create your own using these advanced 
features.

You can use PostScript overlays to generate all your special stationery and store it in the 
printer for use whenever you need it. If you have chosen to install the PCL driver, macros 
perform a similar function.

You can create several overlays or macros, and combine them in any way you like to 
produce a variety of forms and other special stationery. Each image can be printed on just 
the first page of a document, on all pages, on alternate pages, or just the pages that you 
specify.

CREATING POSTSCRIPT OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer 
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on CD with your printer to 
create a “project file,” import the.PRN file(s), and download the generated filter 
(.HST) file to the printer. The project file will contain one or more overlay images 
which are functionally related, such as the cover page and the continuation page 
images for business letters.

3. Use downloaded files to define your overlays ready for use when printing your 
documents.

When printing overlay files to disk, do not select any special features, such as two-sided 
printing or multiple copies. These are not appropriate to overlays, they apply only to your 
final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required 
overlay image and save it.

2. Open your application’s Print… dialogue.

3. Make sure that the selected printer name (1) is 
that of your PostScript printer driver.

4. Select the Print To File (2) option.

5. Click the Properties button (3) to open the 
Document Properties window.

6. On the Overlay tab, choose Create Form from 
the drop-down list (4).

7. Click OK to close the Document Properties window.

8. Click OK again to close the Print dialogue.

9. When prompted for a print file name, enter a 
meaningful name with the extension.PRN.

10. Close your application.

1 3

2

4
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CREATE AND DOWNLOAD THE PROJECT

1. From the Windows Start menu, start Storage Device Manager (SDM) and allow 
SDM to discover the printer.

2. Choose Projects→New Project.

3. Choose Projects→Add File to Project.

4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the.PRN files are stored and select one or more of these 
to include in your overlay set.

You can have more than one printer (.PRN) file in a project. For example, one for top 
pages and another for continuation pages. Use standard Windows techniques (Shift 
or Ctrl keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project.

7. When a message box appears confirming that a filter file has been created, click OK 
to clear the message.

8. The project window will display one.HST file for each printer file added. Make a 
careful note of each of these names. Ensure that you note them exactly as they 
appear, they are case sensitive, and you will need them later.

9. Choose Projects→Save Project and enter a meaningful name (e.g. “Letter 
Stationery”) so that you can recognise it later if you want to modify it.

10. Choose Projects→Send Project Files to Printer to download the project to the 
printer.

If you have a hard disk in the printer, SDM will automatically download files to it. If 
not, SDM will download files to flash memory. If you have a hard disk but still prefer 
to download to flash memory, double-click the file name in the Project window and 
under Volume, type in %Flash0% and then click OK.

11. When the message “Command Issued” appears confirming that the download is 
complete, click OK to clear the message.

TEST PRINTING THE OVERLAY

1. Click on the printer icon for the relevant printer and choose Printers→Test Form.

2. In the Test PostScript Form window, to test each overlay select it and click OK. There 
will be a short pause while the printer processes the form, and then it will print.

3. When each overlay has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects→Exit to close 
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start 
menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing 
Preferences from the pop-up menu.

3. On the Overlay tab, click the New button.
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4. In the Define Overlays window, enter a suitable name (2) 
for this overlay and choose which page(s) (3) of your 
documents will use this overlay.

5. Enter the name of the overlay file (4) exactly as it appeared 
in the Storage Device Manager project window. Remember 
that this name is case sensitive.

If you forgot to note the overlay names when you created 
them, you can find them using Storage Device Manager to 
view the project file, or the printer’s Information Menu to 
print a file list and identify them from there.

6. Click Add (5) to add this overlay into the defined overlays list.

7. Click OK to close the Define Overlay window.

The new overlay now appears in the Defined Overlays list in the printer properties 
window.

8. Repeat the above procedure if you wish to define more overlays.

9. When done, click OK to close the printer properties window.

Your new overlays are now ready and available to be used for any future documents you 
wish.

PRINTING WITH POSTSCRIPT OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you 
wish. The example illustrated here uses two overlays for business letters. The first prints 
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. 
Remember, if necessary, to format the document so that it will fit within the 
appropriate space.

2. Open your application’s Print… dialogue and choose any options you will require, 
ensuring that the target printer is your PostScript printer driver in which the overlays 
have been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Overlays tab, choose Use Overlay from the 
drop-down list (1).

5. Click on the first overlay (2) you wish to use. In this 
example it is the Cover Page overlay. Then click the 
Add button (3).

6. If you want to use another overlay, in this case it is the 
Continuation page, click the second overlay (4) and 
then click the Add button (3) again.

7. When you have selected all the overlays you want to 
use for this document, click OK.

8. Finally, in your application’s print dialogue, click OK to begin printing.

2
3
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CREATING PCL OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer 
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on CD with your printer to 
create a “project file,” import the .PRN file, and download the generated filter (.BIN) 
files to the printer.

3. Use downloaded files to define your overlay ready for use with any future document.

When printing files to disk, do not select any special features, such as two-sided 
printing or multiple copies. These are not appropriate to macros, they apply only to 
your final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required 
image and save it.

2. Open your application’s Print… dialogue.

3. Make sure that the selected printer name (1) is that of 
your PCL printer driver.

4. Select the Print To File (2) option.

5. When prompted for a print file name, enter a 
meaningful name with the extension .PRN .

6. Close your application.

CREATE AND DOWNLOAD MACROS

1. From the Windows Start menu, start Storage Device Manager (SDM) and allow 
SDM to discover the printer.

2. Choose Projects→New Project to start a new project.

3. Choose Projects→Filter Macro File. The Filter Printer Patterns dialogue box 
appears. Make any adjustments in the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave all the colour command 
filters checked, the black oval will print as a black rectangle when the overlay is used. 
To maintain the oval shape, turn off (deselect) the “Configure Image Data,” “Palette 
ID” and “Palette Control” filters.

4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the overlay .PRN files are stored and select one or more 
of these to include in your overlay set.

You can have more than one macro file in a project. For example, one for top pages 
and another for continuation pages. Use standard Windows techniques (Shift or Ctrl 
keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project. (You can also drag and drop files 
from Windows Explorer directly into the project window if you prefer.) When a 
message box appears confirming that a filter file has been created, click OK to clear 
the message.

7. The project window will display one .BIN file for each printer file added. Make a 
careful note of the name and ID number for each of the files. You will need them 
later.

1 3
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If you wish to edit the names or ID numbers, double-click the file entry and edit the 
details. 

Note that the names are case sensitive. 

8. Choose Projects→Save Project and enter a meaningful name (e.g. “Letter 
Stationery”) so that you can recognise it.

9. Choose Projects→Send Project Files to Printer to download the project to the 
printer.

10. When the message “Command Issued” appears confirming that the download is 
complete, click OK to clear the message.

TEST PRINTING THE MACRO

1. Choose Printers→Test Macro.

2. In the Test Macro window, enter its ID number and click OK. After a short pause the 
printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects→Exit to close 
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start 
menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing 
Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click the Define Overlays 
button (1).

5. In the Define Overlays window, enter the name (a) and 
ID (b) of the required overlay, and define which 
page(s) (c) of your documents will use this overlay. Then 
click the Add button (3) to add this overlay to the list of 
defined overlays. Repeat for any other related overlays. 
When done, click the Close button (4) to close the 
window.

The example illustrated shows two overlays defined, one for 
a cover page and one for continuation pages.

Remember that names and IDs of overlay files must be entered exactly as they 
appeared in the Storage Device Manager project window. Remember also that names 
are case sensitive.

If you forgot to note the overlay name or ID when you created them, you can find 
them using Storage Device Manager to view the project file, or the printer’s 
Information Menu to print a file list and identify them from there.

1
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The new overlays will now appear in the Defined Overlays list in the printer properties 
window.

6. When done, click OK to close the printing preferences window.

Your new overlays are now ready and available to be used for any future documents you 
wish.

PRINTING WITH PCL OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you 
wish. The example illustrated here uses two overlays for business letters. The first prints 
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. 
Remember, if necessary, to format the document so that it will fit nicely within the 
plain areas on your letterhead overlay.

2. Open your application’s Print… dialogue and choose any options you will require, 
ensuring that the target printer is your PCL printer driver in which the overlays have 
been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Overlay tab, check the Use active overlays 
checkbox (1).

5. In the Defined Overlays list, click on the first overlay (2) 
you wish to use, and click the Add button (3) to add it to 
the Active Overlays list. (If you want a reminder of how 
this overlay looks, click the Test Print button.)

6. If you want to use another overlay with this document, in 
this example it is the “Continuation Page” overlay, click 
this overlay (4) in the list of defined overlays, and then 
click the Add button (3) again to add the second overlay to the list of active 
overlays.

7. When the list of active overlays contains all the items you want to use, click OK.

8. Finally, click the Print button in your application’s Print dialogue to begin printing 
your document.
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MAINTENANCE

CONSUMABLE LIFE EXPECTANCY

As a guide, the life expectancy of these items is:

> Toner

Starter cartridge:

The machine is shipped with sufficient black toner for 1500 sheets (ISO/IEC19752 
A4).

Replacement cartridge:

3.5k cartridge has a capacity of approximately 3,500 sheets (ISO/IEC19752 A4). If 
the image drum is also replaced at the same time the capacity is approximately 1,750 
sheets (ISO/IEC19752 A4).

7k cartridge has a capacity of approximately 7,000 sheets (ISO/IEC19752 A4).If the 
image drum is also replaced at the same time the capacity is approximately 5,250 
sheets (ISO/IEC19752 A4).

12k cartridge has a capacity of approximately 12000 sheets (ISO/IEC19752 A4).If 
the image drum is also replaced at the same time the capacity is approximately 
10,250 sheets (ISO/IEC19752 A4).

> Image drum: 

Simplex printing on A4 paper yields:

> 25,000 pages (approx.) for continuous printing

> 20,000 pages (approx.) for 3 pages per job (without power save)

> 12,000 pages (approx.) for 1 page per job (without power save)

> 7,000 pages (approx.) for 1 page per job (with power save)

> Duplex printing on A4 paper yields:

> 15,000 pages (approx.) for continuous printing (without power save)

> 13,000 pages (approx.) for 6 page per job (without power save)

> 10,000 pages (approx.) for 2 page per job (without power save)  

 
 

 

 

  

         NOTE
          When the on-screen display indicates that the toner is low, or if print appears 
         faded, first open the top cover and try tapping the cartridge a few times to 
         evenly distribute the toner powder. This will enable you to obtain the best 
         “yield” from your toner cartridge.
Maintenance > 109



CONSUMABLE ORDER DETAILS

Only use genuine original consumables to ensure the best quality and performance from 
your hardware. Non original products may adversely affect your printer's performance and 
invalidate your warranty.

REPLACING CONSUMABLE ITEMS

TONER CARTRIDGE REPLACEMENT

The toner used in this machine is a very fine dry powder. It is contained in one cartridge.

Have a sheet of paper handy so that you have somewhere to place the used cartridge while 
you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the new one came in. Follow 
any regulations, recommendations, etc., which may be in force concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, damp 
cloth to remove any residue.

Do not use hot water, and NEVER use solvents of any kind. They will make stains 
permanent.

ITEM LIFE ORDER NO.

Toner standard - 
MB460, MB470, MB480

3,500 A4@ ISO/IEC19752 43979103

Toner high capacity - 
MB460, MB470, MB480

7,000 A4@ ISO/IEC19752 43979203

Toner high capacity - 
MB480

12,000 A4@ ISO/IEC19752 43979217

Image Drum 25,000 A4 pages 43979003

CAUTION!

To avoid toner wastage and possible toner sensor errors, do not 
change the toner cartridge until “TONER EMPTY” is displayed.

WARNING!

If you inhale any toner or get it in your eyes, drink a little water or 
bathe your eyes liberally in cold water. Seek medical attention 
immediately.
Maintenance > 110



1. Lift the Scanner.

2. Press the cover release (a) and open the top cover (b) fully.

WARNING!

If the MFP has been powered on, the fuser may be hot. This area is 
clearly labelled. Do not touch.

a

b
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3. Pull the coloured toner release lever (1) on the cartridge to be replaced fully towards 
the front of the MFP.

4. Lift the right-hand end of the cartridge and then draw the cartridge to the right to 
release the left-hand end as shown, and withdraw the toner cartridge out of the 
MFP.

5. Put the cartridge down gently onto a piece of paper to prevent toner from marking 
your furniture.

6. Remove the new cartridge from its box but leave its wrapping material in place for 
the moment.

CAUTION!

The green image drum surface is very delicate and light sensitive. 
Do not touch it and do not expose it to normal room light for more 
than 5 minutes. If the toner cartridges need to be out of the MFP 
for longer than this, please lower the top cover. Never expose the 
drum to direct sunlight or very bright room lighting.

1
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7. Gently shake the new cartridge from end to end several times to loosen and 
distribute the toner evenly inside the cartridge.

8. Remove the wrapping material and peel off the adhesive tape from the underside of 
the cartridge.

9. Holding the cartridge by its top centre with the coloured lever to the right, lower it 
into the printer over the image drum unit from which the old cartridge was removed.

10. Insert the left end of the cartridge into the top of the image drum unit first, pushing 
it against the pins on the drum unit, then lower the right end of the cartridge down 
onto the image drum unit.

11. Pressing gently down on the cartridge to ensure that it is firmly seated, push the 
coloured lever towards the rear of the MFP. This will lock the cartridge into place and 
release toner into the image drum unit.

1

2
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12. Close the top cover and press down firmly so that the cover latches closed.

13. Gently lower the scanner.
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IMAGE DRUM REPLACEMENT

1. Lift the scanner.

2. Press the cover release (a) and open the top cover (b) fully.

CAUTION!

Static sensitive devices, handle with care.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

a

b
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3. Holding it by its top centre, lift the image drum, complete with its toner cartridge, up 
and out of the MFP.

4. Put the cartridge down gently onto a piece of paper to prevent toner from marking 
your furniture and to avoid damaging the green drum surface.

5. With the coloured toner release lever to the right, pull the lever towards you. This 
will release the bond between the toner cartridge and the image drum cartridge.

6. Lift the right-hand end of the cartridge and then draw the cartridge to the right to 
release the left-hand end as shown, and withdraw the toner cartridge out of the 
image drum cartridge. Place the cartridge on a piece of paper to avoid marking your 
furniture.

7. Take the new image drum cartridge out of its packaging and place it on the piece of 
paper where the old cartridge was placed. Keep it the same way round as the old 
unit. Pack the old cartridge inside the packaging material for disposal.

8. Place the toner cartridge onto the new image drum cartridge as shown. Push the left 
end in first, and then lower the right end in. (It is not necessary to fit a new toner 
cartridge at this time unless the remaining toner level is very low.)

9. Push the coloured release lever away from you to lock the toner cartridge onto the 
new image drum unit and release toner into it.

CAUTION!

The green image drum surface at the base of the cartridge is very 
delicate and light sensitive. Do not touch it and do not expose it to 
normal room light for more than 5 minutes. If the drum unit needs 
to be out of the MFP for longer than this, please wrap the cartridge 
inside a black plastic bag to keep it away from light. Never expose 
the drum to direct sunlight or very bright room lighting.
Maintenance > 116



10. Holding the complete assembly by its top centre, lower it into place in the MFP, 
locating the pegs at each end into their slots in the sides of the MFP cavity.

11. Close the top cover and press down firmly so that the cover latches closed.

12. Gently lower the scanner.

NOTE
If you need to return or transport this product for any reason, please make 
sure you remove the image drum unit beforehand and place in the bag 
provided. This is to avoid toner spillage. Refer to “Appendix A - Moving and 
transporting” on page 137 for details.
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CLEANING

From time to time print “debris” such as ink, toner and paper dust will accumulate in the 
ADF and the document glass from documents which have been copied.

...THE UNIT CASING

1. Switch off the MFP.

2. Wipe the unit surface with a soft cloth moistened sparingly with water or neutral 
detergent.

3. Use a soft dry cloth to dry the unit surface.

4. Turn on the MFP.

...THE PAPER PATH IN THE ADF

If marks are found on an image, which has been read by the ADF, or the ADF does not feed 
documents smoothly, follow the cleaning procedure below.

1. Switch the MFP OFF.

2. Open the ADF top cover.

3. Pinch the ADF lock lever and swing the feeder mechanism up until it is locked.

CAUTION!

Use a clean, moist, lint-free cloth for cleaning. Do not use benzine, 
thinners or alcohol as a cleaning agent.
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4. Moisten a soft clean lint free cloth and remove any marks by wiping the cloth in the 
direction of the arrow, as shown.

5. Return the feeder mechanism to its original position.

6. Close the ADF top cover.

... THE UNDERSIDE OF THE ADF

1. Open the document cover.

2. Moisten a soft, clean, lint free cloth and remove any marks as shown.

3. Close the document cover.

...THE DOCUMENT GLASS

The document glass needs to be cleaned occasionally to ensure optimum image quality and 
performance.

Clean the glass as follows.
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1. Open the document cover.

2. Moisten a soft, clean, lint-free cloth and remove any marks, as shown.

3. Close the document cover.

...THE LED HEAD

Clean the LED head when printing does not come out clearly, has white lines or when text 
is blurred.

There is no need to switch the MFP off to clean the lens.

1. Lift the scanner.

2. Press the cover release (a) and open the top cover (b) fully.

a

b
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3. Eliminate static electricity by touching the aluminum foil film section before cleaning 
the LED head.

4. Moisten a soft, clean, lint-free cloth and gently wipe the LED head surface.

5. Close the top cover and press down firmly so that the cover latches closed.

6. Gently lower the scanner.

NOTE
Since the printer may be damaged, make sure to clean the LED head after 
eliminating static electricity.

CAUTION!

Do not use methyl alcohol or other solvents on the LED head as 
damage to the lens surface will occur.

Aluminum foil film
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INSTALLING OPTIONS
The following options are available to extend the performance of your printer:

> 64, 256 RAM DIMM: to extend the main memory of your printer and speed up the 
processing of large files.

> Second paper tray: to increase your printer’s paper handling capacity by 530 sheets 
(80g/m2)

INSTALLING OPTIONS ORDER NUMBERS

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation sheet that accompanies 
the option.

OPTIONS ORDER NUMBER

64MB RAM DIMM 44029515

256MB RAM DIMM 44029517

Second Paper Tray 43990707



TROUBLESHOOTING

CLEARING PAPER JAMS

Provided that you follow the recommendations in this guide on use of print media, and you 
keep the media in good condition prior to use, your MFP should give years of reliable 
service. However, paper jams occasionally do occur, and this section explains how to clear 
them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper 
path through the printer or scanner ADF. When a jam occurs, the MFP immediately stops. 
If printing multiple pages (or copies), do not assume that, having cleared an obvious sheet, 
others will not also be stopped somewhere along the path. These must also be removed in 
order to clear the jam fully and restore normal operation.

IN THE SCANNER ADF SECTION...

In the event of a paper jam, follow the procedures below to remove the paper:

1. Lift the ADF cover (1).

2. Remove any loose paper from the entry to the sheet feeder.

3. If there is any paper trapped in the feed mechanism:

(a) Lift the feeder mechanism by the coloured tab (2).

(b) Remove any paper from ADF mechanism.

4. Lower the ADF cover.

5. Press the Stop button to restore the scanning head to the correct position.

1

2
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IN THE PRINTER SECTION...

1. Lift the scanner.

2. If a sheet is well advanced out of the top of the printer, simply grip it and pull gently 
to draw it fully out. If it does not remove easily, do not use excessive force. It can be 
removed from the rear later.

3. Press the cover release (a) and open the MFP’s top cover (b) fully.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

a

b
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4. Holding it by its top centre, lift the image drum, complete with its toner cartridge, up 
and out of the printer.

5. Put the cartridge down gently onto a piece of paper to prevent toner from marking 
your furniture and to avoid damaging the green drum surface. 

6. Remove any jammed sheets from the paper path.

7. Holding the complete assembly by its top centre, lower it into place in the MFP, 
locating the pegs at each end into their slots in the sides of the MFP cavity.

CAUTION!

The green image drum surface at the base of the cartridge is very 
delicate and light sensitive. Do not touch it and do not expose it to 
normal room light for more than 5 minutes. If the drum unit needs 
to be out of the MFP for longer than this, please wrap the cartridge 
inside a black plastic bag to keep it away from light. Never expose 
the drum to direct sunlight or very bright room lighting.
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8. Lower the top cover but do not press down to latch it closed yet. This will protect the 
drums from excessive exposure to room lighting while you check the remaining 
areas for jammed sheets.

9. Open the rear cover and check for a sheet of paper in the rear path area.

Pull out any sheets found in this area.

If the sheet is low down in this area and difficult to remove, it is probably still gripped 
by the fuser. In this case raise the top cover, reach around and press down on the 
fuser pressure release lever.

10. If you are not using the rear exit tray, close it once paper has been removed from 
this area.

11. Remove the Duplex Unit (1) and check for any paper in this area. Remove any paper 
and replace the duplex unit..

NOTE
If the paper is not advanced enough to grip, push the cover (2) in the arrow 
direction, raise it and remove the paper. Refit duplex unit.

1

2
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12. Open the Multi Purpose Tray.

Remove any paper that you find and then close the tray.

13. Pull out the paper tray and remove any paper from the underside of the printer. 
Ensure that all paper is stacked properly, is undamaged, and that the paper guides 
are properly positioned against the edges of the paper stack. When satisfied, replace 
the tray.

14. Close the top cover and press down firmly at both sides so that the cover latches 
closed.

15. Gently lower the scanner.
Troubleshooting > 127



DEALING WITH UNSATISFACTORY PRINTING

SYMPTOMS POSSIBLE CAUSES STEPS TO TAKE

Vertical white lines can 
be seen on the printed 
page.

The LED head is dirty. Wipe the LED head with a 
soft, lint-free cloth.

The toner is low. Open the top cover and tap 
the cartridge a few times to 
evenly distribute any 
remaining toner. If 
symptoms persist, replace 
the toner cartridge.

Foreign materials may be 
present in the image drum.

Replace the image drum 
cartridge.

Light-shielding film of the 
image drum cartridge is 
dirty.

Wipe the film with a soft, 
lint-free cloth.

Printed images are 
fading vertically.

The LED head is dirty. Wipe the LED head with a 
soft, lint-free cloth.

The toner is low. Open the top cover and tap 
the cartridge a few times to 
evenly distribute any 
remaining toner. If 
symptoms persist, replace 
the toner cartridge.

The paper is not suitable for 
the printer unit.

Use recommended paper.

Printing is light. The toner cartridge is not 
properly seated.

Reinstall the toner cartridge.

The toner is low. Open the top cover and tap 
the cartridge a few times to 
evenly distribute any 
remaining toner. If 
symptoms persist, replace 
the toner cartridge.

The paper is moist. Use paper stored in proper 
temperature and humidity 
conditions.

The paper is not suitable for 
the printer unit.

Use recommended paper.

Thickness and type of paper 
are inappropriate.

Set a proper value for Media 
Weight and Media Type in 
the Paper Setup menu, or 
set one value thicker for 
Media Weight.

Recycled paper is being used. Set one value thicker for 
Media Weight in the Paper 
Setup menu.

Partially faded images. 
White spots and lines 
appear in solid 
printing.

Paper is moist or dry. Use paper stored in proper 
temperature and humidity 
conditions.
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DEALING WITH UNSATISFACTORY COPYING

As well as the suggestions provided in “Dealing with unsatisfactory printing” on page 128, 
ensure that the scanner unit glass is clean at all times. Refer to “...the document glass” on 
page 119.

Vertical lines appear. The image drum cartridge is 
damaged.

Replace the image drum 
cartridge.

The toner is low. Open the top cover and tap 
the cartridge a few times to 
evenly distribute any 
remaining toner. If 
symptoms persist, replace 
the toner cartridge.

Horizontal Lines and 
spots appear 
periodically.

When the interval is about 
94mm (4in), the image drum 
(the green tube) is damaged 
or dirty.

Wipe it lightly with a soft 
cloth. Replace the image 
drum cartridge when it is 
damaged.

When the interval is about 
42mm (1.5in), there may be 
foreign particles in the image 
drum cartridge.

Open/close the top cover, 
and print again.

When the interval is about 
87mm (3.5in), the fuser unit 
is damaged.

Replace the fuser unit.

The image drum cartridge 
has been exposed to light.

Replace the image drum 
cartridge if the problem is 
not resolved.

White area of paper is 
lightly stained.

Paper contains static. Use paper stored in proper 
temperature and humidity 
conditions.

Too thick paper is used. Use thinner paper.

The toner is low. Open the top cover and tap 
the cartridge a few times to 
evenly distribute any 
remaining toner. If 
symptoms persist, replace 
the toner cartridge.

Periphery of the letters 
is smudged.

The LED head is dirty. Wipe the LED head with a 
soft, lint-free cloth.

Toner comes off when 
it is rubbed.

The thickness and type of the 
paper are incorrectly set.

Set the correct value of 
Media Type and Media 
Weight in the Printer menu 
or set one value thicker for 
Media Weight.

Recycled paper is used. Set one value thicker for 
Media Weight in the Printer 
menu.

Glossiness is not 
uniform.

The thickness and type of the 
paper are incorrectly set.

Set the correct value of 
Media Type and Media 
Weight in the Printer menu 
or set one value lighter for 
Media Weight.

SYMPTOMS POSSIBLE CAUSES STEPS TO TAKE
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FAX PROBLEM CHECKLIST (MB470/MB480)
If a problem occurs, read through the list of problems and solutions before calling for 
service.

The MFP will not dial a telephone number. Check the power cable and wall outlet. Make 
sure that the telephone line (not external telephone or handset) is connected to the LINE 
socket on the back of the machine. If an external telephone is installed, lift the handset and 
check for a dial tone. If there is no dial tone, there may be a problem with the telephone 
line. If there is a dial tone, the MFP may be using the wrong dialling method (pulse or tone) 
for the region. If alternating tones are heard instead of dialling pulses and the region uses 
pulse dialling, change the call parameters (see “MF(Tone)/DP(Pulse)” on page 45).

The display shows a communications error. This indicates any of a number of problems:

> The MFP may be incompatible with the remote machine, or the remote machine may 
not be able to perform the function requested of it such as polling or confidential 
faxing.

> The remote machine may also be out of paper or experiencing a paper jam.

> Bad telephone line conditions can also cause communication errors. Try sending the 
fax again and check to make sure that the correct telephone number is being dialled.

> If a prefix number must be dialled to get an outside line, or if the call is to an 
international destination, a pause may need to be entered after the dial prefix or 
international dialling code to tell the machine to wait for a dial tone. If there are 
frequent problems communicating with a particular remote machine, try 
programming the telephone number into a speed dial key, and then change the 
parameters for that key.

> Lastly, either the local or remote machine may require servicing. Try sending a fax 
to another location to check the local MFP.

Faxing is possible but the image of the document printed by the remote machine 
is very poor. If the faxed document has small type, complex illustrations, photos, or is 
very light or very dark, try changing the fax quality and density settings (see “Density” on 
page 40). Copy the document on the machine to determine how it will transmit. The 
problem may be caused by telephone line interference. Try sending the document again 
later.

Fax sent but received message was completely blank. Make sure that the document 
is loaded correctly before faxing; with text face UP in the ADF or face DOWN on the glass.

Image of received fax is very poor. Try making a copy of a document on the local 
machine to make sure it is working properly. If there is still a problem, contact the person 
sending the fax and ask them to change their fax quality and density settings. Ask the 
person to make a copy of the document on their machine to ensure that it is working 
properly. Then ask them to send the fax again.

Dialling was tried with a Speed Dial/ Group Dial number but nothing happened. 
Make sure that the Speed Dial/ Group Dial number being used is programmed 
correctly.When dialling a two or three digit number, be sure press # or * before entering 
the number.

Documents received are light or have vertical streaks on them, and MFP is not out 
of toner. Lift the top cover and gently wipe the lens surface of the MFP’s LED array. Then 
check to see if the toner or image drum need replacing (see “Replacing consumable items” 
on page 110).

MFP is set for delayed transmission but it did not send. Check the display to make 
sure that the MFP is set to the correct time and date (see “Clock Adjustment” on page 44).

MFP is connected to a PBX but it is not possible to dial out. Be certain that the dial 
prefix is entered before the telephone number for each number dialled or programmed into 
Troubleshooting > 130



the  machine. Additionally, the machine must be programmed for PBX operation before it 
will work with a PBX (see “Connecting to a PBX” on page 52 ).

MFP always answers before it is possible to use the external telephone. If an 
external telephone is connected, change the MFP’s ring response setting (“Ring Response” 
on page 45). 

Faxes received sometimes look distorted. If the document received is wider or longer 
than the paper loaded in the paper tray, the machine automatically reduces the width or 
length of the document so that it will fit on the paper. This type of problem could also be 
communication related.
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SPECIFICATIONS

MFP

MODEL
NUMBER

MB460 MB470 MB480

N22131B N22132B N22133B

ITEM SPECIFICATION

General

Dimensions

MB460/MB470

MB480

447 x 432 x 500mm (W x D x H)

447 x 432 x 529mm (W x D x H)

Weight 

MB460

MB470

MB480

approximately:

17kg

18.5kg

19kg

Power source Input: 220 to 240VAC, 50 to 60Hz ± 2%

Power consumption Operating: 800W max.

Normal operating: 500W 

Stand-by: 100W 

Power save mode: 10W max.

Environmental:

Noise (operating)
         (standby)

Temperature

Humidity

56dBA
32dBA

10˚C to 32˚C

20% to 80% RH

Scanning

Image sensor Colour CCD

Light source Cold Cathode Fluorescent Lamp (CCFL)

ADF - Simplex 50 sheets (60 ~ 105 g/m2)

Optical resolution Flatbed: 1200 x 600dpi

ADF: 1200 X 300dpi 

Scanner life

Flatbed

ADF

50,000 pages or 5 years

240,000 pages or 5 years.

Scan area

Flatbed

ADF

105mm x 148mm ~ 215.9mm x 296.9mm

105mm x 148mm ~ 215.9mm x 355.6mm

Document size

Flatbed

ADF

B5, A5, A4, Letter

B5, A5, A4, Letter, Legal 13, Legal 13.5, Legal 14

Document thickness

Flatbed

ADF

11 mm 

60 - 105 g/m2
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File Format

Scan to Email/Server

Actkey

PDF, TIFF, JPEG

PDF, TIFF, JPEG, BMP, PCX, GIF, TGA, PNG, WMF, EMF, 
Multi-PDF, Multi-TIFF

Driver TWAIN, WIA

Paper feed ADF: Face up

Copy Specification

Speed ADF: 21 cpm (copies per minute), A4, 300dpi
        22 cpm, Letter, 300dpi

Number of copies Up to 99

Resolution Scan: 600 x 600dpi, 300 x 300dpi
Print: 600 x 600dpi

Paper size

Flatbed

ADF

B5, A5, A4, Letter

B5, A5, A4, Letter, Legal 13, Legal 13.5, Legal 14

Density 7 levels

Copy Mode Mixed, Photo: 300dpi Scan/ 600dpi Print
Hires. Mixed, Hires. Photo: 600dpi Scan/ 600dpi Print

Input tray Tray 1/MP Tray/Tray 2 (optional)

Edge erase Top, Bottom, Left, Right Edge: 0 ~ 1in

Margin shift Bottom, Right direction: 0 ~ 1in

Paper saving (N-in-1) 2-up, 4-up

Collate 64MB standard memory: 25 pages A4 (ITU-T#1)

320MB optional memory: 50 pages A4 (ITU-T#1)
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Network Specification

Connectivity Ethernet 100Base-TX/10Base-T auto-negotiation with 
RJ-45 connector

Network protocol TCP/IP:
Network layer - ARP, IPv4/v6, ICMPv4/v6
Transport layer - TCP, UDP
Application layer - LPR, FTP, TELNET, HTTP (except IPP), 
IPP, DHCP/BOOTP, SMTP, WINS, SNMPv1/v3, DNS, 
DDNS, UPnP, Bonjour, POP3, SNTP, WSDPrint, Kerberos

NetBEUI:
SMB, NetBIOS, CIFS, WINS

Netware:
Remote printer mode (max. 8 print servers)
Print server mode (max. 8 file server, 32 queues)
Encrypted password support (in print server mode)
NetWare6J/5J/4.1J (NDS, boundary)
SNMP

ETHERTALK:
ELAP, AARP, DDP, AEP, NBP, ZIP, RTMP, ATP, PAP 
IEEE802.1X

IEEE802.1X:
EAP-TLS, PEAP

Supported browsers Microsoft IE 5.5 or higher

Netscape Navigator 6.0 or higher

Configuration requirement IP address 

Subnet mask

Gateway

SMTP server/POP3 server

FTP server

Web server

Fax Specification (MB470/MB480)

Circuits PSTN, PBX line

Compatibility ITU-T G3/Super G3 

Transmission speed 3sec per page 

Line interface Dual RJ-11C (Line and TEL)

Compression method MH, MR, MMR

Resolution:

Standard

Fine

Photo

Extra fine

200 x 100dpi

200 x 200dpi

200 x 200dpi

200 x 400dpi

Speed dials 100 (max. 32 digits each location)

Group dial max 10 groups

Auto redial Yes

One touch dial 5 x 2 location (with shift key)

Sender ID Yes (max. 32 characters)

Transmission:

Broadcast Yes (max. 100 transmissions)
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Delayed Yes (up to 5 transmissions; up to one month from 
current date/time)

Receive:

Memory Yes, receives even when printer error or paper out 
situation occurs

Remote Yes

E-mail Specification

Communication protocol SMTP, MIME, POP3

File formats PDF, M-TIFF, JPEG 

Default file format PDF

Resolution 100, 150, 200, 300dpi (400, 600dpi 1 bit mono only)

Default resolution

B/W

Grey/Colour

200dpi

150dpi

Address book volume:

Max. e-mail addresses

Group

100

20

Multi “Subject” registration Yes, 5 kinds of “Subject”

Job Build Scanning Yes

Separation limit 1MB, 3MB, 5MB, 10MB, 30MB, No limit

Mail server authentication SMTP-Auth, POP3

Supported mail server 
application

Supported LDAP server

Supported mail application

Lotus Mail Server 5.0

MS Exchange Server 2000

RedHat 7.0 SendMail

Windows 2003 Active Directory

Windows 2000 Active Directory

Windows NT 4.0 + MS Exchange 5.5

Lotus Notes R5

Microsoft Outlook 2000

Microsoft Outlook Express 5.0

Microsoft Outlook Express 6.0

Netscape Messenger 4.7

Netscape Messenger 4.73

Eudora 4.3.2J

Lotus Notes R5

Apple Mail
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Filing Specification

Communication protocol FTP, CIFS

File formats: PDF, M-TIFF, JPEG 

Default file format PDF

Resolution 100, 150, 200, 300dpi (400, 600dpi 1 bit mono only)

Default resolution

B/W

Grey/Colour

200dpi

150dpi

Max. number of File server 
settings

20

Job Build Scanning Yes

Printing

Speed Letter: 30ppm
A4: 28ppm

Resolution

MB460

MB470/MB480

600 x 600dpi, 1200 x 600dpi, 2400 x 600dpi (half 
speed)

Optical: 600dpi

1200 x 1200dpi, 600 x 600dpi

Optical: 1200dpi

Memory 64MB standard, upgradeable to 320MB max.

Paper capacity at 80g/m2

Main tray

Multi purpose tray

Optional 2nd tray

MB460/MB470: 250 sheets 

MB480: 530 sheets 

MB460: Manual single sheet feed 

MB470/MB480: 50 sheets 

530 sheets 

Paper weight 60 ~ 120g/m2 in main tray

60 ~ 163g/m2 in multi purpose tray

60 ~ 120g/m2 in optional 2nd tray

60 ~ 105g/m2 duplex print

Paper output 150 sheets in face down (top) stacker @ <80g/m2

Printer life 200,000 pages or 5 years

Duty cycle MB460, MB470: 50,000 pages per month max. 

MB480: 70,000 pages per month max.

Toner life Starter: 1500 pages

Replacement:

MB460: 3500 pages, 7000 pages

MB470: 3500 pages, 7000 pages

MB480: 3500 pages, 7000 pages, 12000 pages

Image drum life 20,000 pages at 3 pages per job (simplex)
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APPENDIX A - MOVING AND TRANSPORTING

MOVING YOUR MFP

1. Turn off the MFP and disconnect or remove the following:

> Power cord

> Printer cable

> Paper in the paper cassette

2. Move the MFP to the new location.

TRANSPORTING YOUR MFP

1. Turn off the MFP and disconnect or remove the following:

> Power cord

> Printer cable

> Paper in the paper cassette

2. Lift the scanner.

NOTE
Lock the scanner before moving the MFP.

WARNING!

This product is heavy; a minimum of two people are required to lift 
it safely. 

NOTE
Be sure to unlock the scanner before turning on the MFP.

WARNING!

Your MFP is a precision machine and can be damaged during 
transportation if packaged incorrectly.

NOTE
> If your machine is equipped with the additional paper tray remove it 

before transporting.

> Lock the scanner before transporting the MFP.
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3. Press the cover release (a) and open the top cover (b) fully.

4. Lift the image drum along with the toner cartridge out of the MFP and place it on a 
flat table.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

CAUTION!

The green image drum surface at the base of each cartridge is very 
delicate and light sensitive. Do not touch it and do not expose it to 
normal room light for more than 5 minutes. Never expose the drum 
to direct sunlight or very bright room lighting.

a

b
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5. Place the drum and cartridge in a black bag plastic bag.

6. Re-install the image drum along with the toner cartridge back into the MFP.

7. Close the top cover and press down firmly so that the cover latches closed.

8. Gently lower the scanner.

9. Protect the MFP with cushion pads and put it in a box.

NOTE
It is recommended that you use the original box and packaging if available.

WARNING!

This product is heavy; a minimum of two people are required to lift 
it safely. 

NOTE
Be sure to unlock the scanner before turning on the MFP.
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Oki Systems (UK) Limited
550 Dundee Road
Slough Trading Estate
Slough, SL1 4LE

Tel:44 (0) 1753 819819
Fax:44 (0) 1753 819899
http://www.okiprintingsolutions.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght, Dublin 24, Ireland

Tel:+353 1 4049590
Fax:+353 1 4049591
http://www.oki.ie

OKI Systems - Northern Ireland
40 Sydenham Park
Belfast, BT4 1PW

Tel:+44 (0)28 90 20 1110
http://www.oki.ie

Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie

Oki Data Corporation
4-11-22 Shibaura, Minato-ku, Tokyo 
108-8551, Japan

Tel:(81) 3 5445 6158
Fax:(81) 3 5445 6189
http://www.okidata.co.jp

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12
Lobby 3, Alexandra Technopark
Singapore (119967)

Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/79, 81-82 Lumpini Tower,
27th Floor, Rama IV Rd.,
Tungmahamek, Sathorn
Bangkok 10120

Tel: +66 2679 9235 
Fax:+66 2679 9243
http://www.okisysthai.com

Oki Systems (Hong Kong) Ltd.
Unit 607 6/F, Island Place Tower,
510 King's Road
North Point
Hong Kong

Tel: (852) 3543 9200
Fax: (852) 3549 6040
http://www.okiprintingsolutions.com.hk

Oki Data (Australia) Pty. Ltd.
146 O'Riordan Street, Mascot, 
NSW 2020 Australia

Tel: +61 (02) 9667 7240
Fax: +61 (02) 9667 7333
http://www.oki.com.au

Comworth Systems Ltd.
10 Constellation Drive Mairangi Bay, 
Auckland, New Zealand

Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep 
Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City, 
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166
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